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Program szkolenia „Obsługa programów systemu informacji 
przestrzennej – ArcGIS i Geomedia” 

Zagadnienie Czas trwania 

Wprowadzenie do programu GeoMedia 

 Charakterystyka systemu 

 Tworzenie geoprzestrzeni 

 Podłączanie istniejących baz danych 

 Zmiana systemu współrzędnych geoprzestrzeni 

 Praca z klasami obiektów w oknie mapy i oknie tabeli 

 Legenda mapy – zmiana atrybutów wyświetlania 

1 godzina 

Tworzenie i edycja obiektów 

 Tworzenie nowej geohurtowni 

 Kalibracja rastra 

 Tworzenie klas obiektów 

 Digitalizacja mapy w bazie wielodostępowej 

 Kontrola poprawności topologicznej 

3 godziny 

Praca z zewnętrzną bazą danych atrybutowych. Tworzenie map tematycznych  

 Moduł tworzenia map tematycznych w programie 

 Tworzenie mapy tematycznej dla danych jakościowych 

 Podłączanie danych nieprzestrzennych z zewnętrznych źródeł (np.GUS) 

 Tworzenie mapy tematycznej – metoda kartogramu 

 Tworzenie kompozycji mapy w oknie rozkładu 

3 godziny 

Przegląd wybranych narzędzi do zapytao przestrzennych  

 Atrybut funkcyjny 

 Zapytanie atrybutowe 

 Zapytanie przestrzenne 

2 godziny 

Przegląd wybranych narzędzi do analiz przestrzennych 

 Iloczyn i różnica przestrzenna 

 Strefa buforowa 

 Scalenie analityczne 

 Agregacja 

3 godziny 
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Wprowadzenie do programu ArcGIS  

 Charakterystyka systemu 

 Zakładanie projektu, tworzenie geobazy 

 Praca w ArcCatalog 

 Ustawienia systemu odniesienia. 

 Praca z klasami obiektów i warstwami 

1 godzina 

Tworzenie i edycja obiektów 

 Tworzenie klas obiektów 

 Praca z serwerami WMS 

 Digitalizacja wybranych warstw tematycznych 

 Edycja obiektów (geometria, atrybuty) 

2,5 godziny 

Tworzenie map tematycznych 

 Moduł tworzenia map tematycznych w programie 

 Przekształcenie danych jakościowych (mapa zasięgów) na dane w skali 
ilościowej  

 Funkcja Join i aktualizacja atrybutów w bazie 

 Tworzenie mapy tematycznej – metoda kartogramu a metoda dazymetryczna 

 Tworzenie kompozycji mapy w oknie rozkładu 

2,5 godziny 

Analizy przestrzenne - wektorowy model danych 

 Zapytania atrybutowe 

 Proste analizy przestrzenne na modelu wektorowym danych 

Analizy wektorowe realizowane przy pomocy geoprzetwarzania 

3 godziny 

Proste analizy przestrzenne - rastrowy model danych 

Analizy rastrowe realizowane przy pomocy geoprzetwarzania 

3 godziny 
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1.  Systemy GIS jako systemy bazodanowe 

Systemy informacji przestrzennej są zespołem środków technicznych, prawnych i organizacyjnych 

nastawionych na gromadzenie, przetwarzanie i udostępnianie danych o charakterze przestrzennym. 

Skupiając się na aspektach technicznych systemów GIS najważniejszą częścią są tutaj bazy danych 

i systemy zarządzania nimi. Zatem systemy GIS mogą byd uważane za technologię informatyczną 

integrującą dane o charakterze przestrzennym (chod często również nieprzestrzennym) w bazach 

danych umożliwiając ich wizualizację, wyszukiwanie, łączenie i analizę. Zatem znajomośd podstaw 

funkcjonowania baz danych jest niezbędna każdemu użytkownikowi systemów GIS.  

Jak wspomniano powyżej systemy GIS zasilane są danymi mającymi odniesienie do przestrzeni 

geograficznej. Schematyczny podział danych dla tych systemów zaprezentowano na poniższym 

rysunku.

 

Rys. 1. Podział danych dla GIS 

Różny charakter danych powoduje, że są one przechowywane w formie cyfrowej w różnych 

formatach i różnej postaci. Nie zmienia to jednak faktu, że wszystkie dane muszę byd zarządzane 

przez system bazodanowy, co jest warunkiem korzystania z nich w przypadku złożonych analiz 

przestrzennych wymagających integracji z innymi danymi.  

1.1 Podstawowe pojęcia z zakresu baz danych 

Baza danych jest to wspólnie wykorzystywany zbiór logicznie połączonych danych, umożliwiający 

spełnianie potrzeb informacyjnych oraz reprezentujący bieżący stan obiektów poprzez ich umowną 

reprezentację. Zatem baza danych stanowi zbiór danych i sama w sobie nie jest zintegrowana z 

narzędziami i aplikacjami tworzonymi do manipulacji danymi za jej pośrednictwem. Definiuje się 

zatem pojęcie systemu zarządzania bazą danych, który stanowią zasoby językowe i aplikacyjne, 

przeznaczone do stworzenia oraz wspólnego wykorzystania danych przez wielu użytkowników. 

Rozdział tych zadao wynika z potrzeby uniwersalności dostępu do baz danych i często wąskiej 
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specjalizacji i zmienności aplikacji z nich korzystających. 

Oczywiście istnieje wiele pomysłów na organizację danych w postaci bazy danych. Bazy danych mogą 

byd oparte o następujące modele logiczne: 

a) dokumentalny, 

b) hierarchiczny, 

c) sieciowy, 

d) relacyjny (relacyjno-obiektowy), 

e) obiektowy. 

Pierwsze trzy mają obecnie charakter historyczny, a ostatni nie znajduje szerokich zastosowao 

w praktyce, dlatego nie zostaną tu omówione. Natomiast model relacyjny zasługuje na szczególną 

uwagę i jest omówiony poniżej. Model relacyjno-obiektowy jest pochodną modelu relacyjnego 

i pozwala na manipulację danymi jako zestawem obiektów (obiekty mogą posiadad nie tylko 

atrybuty, ale również zdefiniowane dla nich metody czyli funkcje i procedury),  jako mechanizm 

wewnętrzny bazy relacyjno-obiektowe działają jednak w oparciu o model relacyjny.  

1.2 Relacyjne bazy danych 

Relacyjny model danych oparty jest o pojęcie relacji, czyli dwuwymiarowej tabeli (rys. 2).  

 

Rys. 2. Przykład relacji (tabeli) obiektów typu „działka” 

Każda tabela stanowi reprezentację zbioru obiektów jednego rodzaju (np. osób). Każda kolumna 

w tabeli zawiera zbiór atrybutów obiektów jednakowego typu (np. nazwiska). Ważne jest aby 

w pojedynczej kolumnie nie przechowywad atrybutów możliwych do podziału – czyli np. adres 

zamieszkania należy rozbid na miasto, ulicę, nr itd. i każdy z tych atrybutów przechowywad w osobnej 

kolumnie. Podział tabeli na kolumny wymaga zdefiniowania typu danych jaki każda kolumna ma 

przechowywad. Należy zatem znad podstawowe typy danych. Chod mogą się one różnid szczegółami 

w zależności od producenta systemu, to w większości oparte są o typy informatyczne. Oto przykłady: 
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Tabela 1. Przykładowe typy danych 

Typ Opis Wielkośd  

char(n) Ciąg znaków o długości n n bajtów 

varchar(n) 
Ciąg znaków o zmiennej długości i 

określonej maksymalnej długości 
 

text Ciąg znaków o nieokreślonej długości  

int 
Liczba całkowita z zakresu:     

- 2147483648 do 2147483647 
4 bajty 

single 
Liczba rzeczywista z zakresu: 

od ok. ±1,5*10 -45 do ±3,4*1038 
4 bajty 

double 
Liczba rzeczywista z zakresu: 

od ok. ±5*10 -324 do ±1,8*10308 
8 bajtów 

date data 3 bajty 

binary Dane binarne (np. obrazy) jak dane 

yes/no Dane logiczne 1 bit 

 

Zbiór wszystkich atrybutów obiektu (czyli wiersz) jest reprezentacją jednego konkretnego obiektu 

(czyli np. konkretnej osoby) i nazywany jest krotką. Ponieważ w większości baz danych 

przechowywane są informacje o różnych typach obiektów – projektuje się dla każdego typu 

oddzielną tabelę. Taka organizacja danych zapewnia intuicyjną transpozycję rzeczywistości na 

reprezentację informatyczną. Wymaga jednak zdefiniowania szybkich sposobów łączenia danych. 

Takie połączenia zapewniają identyfikatory obiektów czyli klucze główne.  

Klucz główny relacji (ang. primary key) – jest to atrybut lub zbiór minimalny atrybutów, których 

wartości jednoznacznie identyfikują wszystkie krotki relacji. Klucz główny oprócz warunku 

minimalności musi byd niepowtarzalny i nie może byd pusty (musi zostad nadany każdemu 

wierszowi). Istnienie klucza głównego jako atrybutu sprawia, że nie istnieje koniecznośd 

przestrzegania kolejności wierszy w relacji – jest ona dowolna. 

Podsumowując cechy tabeli w bazie danych to: 

 musi mied jednoznaczna nazwę, 

 każda kolumna ma jednoznaczną nazwę w obrębie jednej tabeli, 
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 wszystkie wartości w kolumnie są tego samego typu, 

 w każdej tabeli jest przynajmniej jedna kolumna, 

 nie są dozwolone powtórzenia całych wierszy w tabeli, 

 relacja może istnied bez wierszy, 

 nie jest dozwolone przechowywanie zbioru wartości na przecięciu kolumny i wiersza tabeli - 

każdy element danych musi byd nierozkładalny, 

 nie jest istotny porządek wierszy tabeli, 

 do rozróżnienia wierszy służą klucze główne, a nie kolejnośd, 

 nie jest istotny porządek kolumn tabeli. 

 

Ponadto w tabeli wyróżnid można również klucz obcy (ang. foreign key) - to jest atrybut relacji, 

którego wartośd jest wartością klucza głównego pewnej innej relacji. Dzięki warunkowi minimalności 

dołączenie identyfikatora obiektu z jednej relacji do atrybutów innej umożliwia utrwalenie związku 

pomiędzy obiektami z różnych relacji. To w jaki sposób to połączenie jest realizowane zależy od typu 

związku między relacjami.  

Wyróżnia się trzy typy związków relacji: 

a) związek jeden-do-jednego (1:1) 

Występuje wtedy, kiedy obiekt z jednej tabeli jest powiązany z co najwyżej jednym obiektem 

z drugiej i odwrotnie. Przypadek taki rzadko występuje w rzeczywistości i sprowadza się do 

tego, że dwie tabele można przedstawid jako jedną tabelę.  

Przykładowo, gdyby prawo pozwalało na posiadanie tylko jednej nieruchomości gruntowej 

przykładowy wykaz właścicieli i posiadanych przez nich nieruchomości mógłby wyglądad 

następująco: 

 

 

 

 

b) związek jeden-do-wielu (1:n) 

Występuje w przypadku gdy jednemu obiektowi danego typu odpowiada zero lub więcej 

obiektów drugiego typu, ale obiektowi typu drugiego tylko jeden typu pierwszego.  

Przykładowo taka sytuacja miała by miejsce gdyby prawo pozwalało na posiadanie więcej niż 

jednej nieruchomości jednak niedozwolona by była współwłasnośd. Dane obu typów nie 

mogły by byd w tym przypadku przedstawione w jednej tabeli bez powtarzania wartości 

wszystkich atrybutów. Połączenie realizuje się wstawiając do tabeli obiektów drugiego typu 

identyfikatora (klucza) obiektu typu pierwszego.  

Właściciele:      Działki: 

Imię Nazwisko Ulica NrD NrL PESEL

Jan Nowak Świdnicka 53 1 61080301345

Maria Nowak Świdnicka 53 1 65030202897

Stanisław Kowalski Grunwaldzka 23 3 47020103786         

Nr Obręb NrKw Pow PESEL

121/1 2345 123/98 450.45 61080301345

121/2 2345 124/98 449.67 61080301345

123 2345 150/99 1200.23 47020103786  

Imię Nazwisko Ulica NrD NrL PESEL Nr Obręb NrKw Pow

Jan Nowak Świdnicka 53 1 61080301345 121/1 2345 123/98 450.45

Maria Nowak Świdnicka 53 1 65030202897

Stanisław Kowalski Grunwaldzka 23 3 47020103786 123 2345 150/99 1200.23



 
 
 

13 

c) związek wiele-do-wielu (n:m) 

Przypadek najbardziej ogólny. Jednemu obiektowi pierwszego typu odpowiada dowolna ilośd 

obiektów typu drugiego i odwrotnie. 

Tutaj aby zaznaczyd związek między obiektami niezbędne jest stworzenie dodatkowej tabeli, 

która będzie przechowywała pary kluczy głównych z tabel które ma łączyd. Dzięki temu 

redundancja (nadmiarowośd) informacji w bazie danych redukowana jest do powtórzeo 

identyfikatorów.  

Właściciele:       Działki: 

Imię Nazwisko Ulica NrD NrL PESEL

Jan Nowak Świdnicka 53 1 61080301345

Maria Nowak Świdnicka 53 1 65030202897

Stanisław Kowalski Grunwaldzka 23 3 47020103786                 

Nr Obręb NrKw Pow

121/1 2345 123/98 450.45

121/2 2345 124/98 449.67

123 2345 150/99 1200.23  

Własnośd: 

PESEL NrDzialki Obręb

61080301345 121/1 2345

61080301345 123 2345

47020103786 123 2345  

W przypadku posiadania nieruchomości taka sytuacja jest w rzeczywistości. Związek relacji 

przedstawid można w postaci schematu: 

 

1.3 Integralność danych 

Dane w bazach danych w odróżnieniu od danych przechowywanych w systemie plików poza bazami 

są objęte regułami i powiązane ze sobą w celu zapewnienia ich integralności, czyli ich spójności, 

kompletności i jednoznaczności. Więzy te nazywane są więzami integralności. Np. integralnośd 

dziedziny zapewnia ograniczenie typu danych w kolumnie. Baza może nie pozwolid na pozostawienie 

pustej wartości w danej kolumnie (wartośd obligatoryjna), proponowad wartośd domyślną lub 

ograniczyd rozpiętośd przedziału wartości dopuszczalnych (np. atrybut wzrost  nie może byd ujemny). 

W przypadku klas obiektów (tabel) powiązanych ze sobą za pomocą kluczy często definiuje się 

mechanizmy uniemożliwiające wprowadzenie do tabeli podrzędnej wartości klucza obcego, który nie 

istnieje w tabeli nadrzędnej (np. nie można wprowadzid do kolumny „PESEL” w tabeli „Wlasnosc” na 

rysunku powyżej wartości której nie ma w tabeli „Wlasciciele” w kolumnie „PESEL”). W podobny 

sposób można wymusid kaskadową aktualizację kluczy obcych w tabelach podrzędnych w przypadku 

zmiany lub usunięcia klucza głównego w tabeli nadrzędnej. 
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1.4 Wyszukiwanie danych 

Podstawnym zadaniem systemów bazodanowych jest wspomaganie decyzji poprzez eksplorację 

i analizę zgromadzonych danych. Uniwersalnym sposobem komunikacji z większością baz danych jest 

język SQL. Język ten jest nieproceduralnym językiem poleceo i w większości przypadków obsługiwany 

jest za pomocą interfejsu graficznego. W celu połączenia danych z różnych tabel i wyświetlenia ich 

w formie jednej tabeli stosuje się polecenie: 

SELECT które_kolumny (* oznacza wszystkie) 

FROM z_której_tabeli  

WHERE warunek; 

Przykładowo wybór kolumny „Nazwisko” z tabeli „Wlasciciele” wygląda następująco: 

SELECT Nazwisko FROM Właściciele 

W warunku można definiowad kryteria selekcji. Np. wyszukanie osób o nazwisku „Kowalski”: 

SELECT Nazwisko FROM Wlasciciele WHERE Nazwisko = „Kowalski” 

W przypadku łączenia tabel w warunku należy podad dodatkowo pary klucz główny-klucz obcy tabel 

z których dane pobieramy. Przykład dla wyszukania numerów działek posiadanych przez osoby 

o nazwisku Kowalski: 

SELECT Nazwisko, Nr_dzialki FROM Wlascicele, Wlasnosc WHERE Nazwisko = „Kowalski” AND 

Wlasciciele.PESEL = Wlasnosc.PESEL 

Dodatkowo wyszukiwane dane można agregowad stosując różne funkcje np. ilości (count), sumy 

(sum), średniej (avg), minimum (min), maksimum (max) itp. Przykład obliczenia liczby działek 

posiadanych przez osoby o nazwisku Kowalski: 

SELECT Nazwisko, count(Nr_dzialki) FROM Wlascicele, Wlasnosc WHERE Nazwisko = „Kowalski” AND 

Wlasciciele.PESEL = Wlasnosc.PESEL GROUP BY Nazwisko 

Poszczególne elementy tego polecenia należy również wskazad w przypadku zapytao za pomocą 

interfejsu graficznego np. zapytao atrybutowych w programie Geomedia czy wyszukiwania po 

atrybucie w programie ArcGIS: 
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W wielu systemach bazodanowych (w tym Geomadia, ArcGIS) pożądane jest przechowywanie 

informacji o związkach między tabelami a nie definiowanie ich przy każdym zapytaniu. Aby powiązad 

ze sobą tabele (klasy obiektów) w aplikacji ArcMap (ArcGIS) udostępnione jest narzędzie JOIN and 

RELATES  a w systemie Geomedia narzędzie JOIN: 

 

Opcja JOIN w obu przypadkach wykorzystywana jest dla związków jeden-do-jednego i wiele-do-

jednego. Wynikiem jej działania jest jedna wspólna tabela danych zawierająca dane z obu łączonych 

tabel. Istnieją cztery podstawowe odmiany funkcji JOIN: 

a) Inner – zwraca tylko te wiersze, które mają odpowiedniki (wspólny atrybut wiążący) w obu 

tabelach. 
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b) Right – zwraca wszystkie wiersze z pierwszej tabeli i odpowiedniki z drugiej jeżeli istnieją 

(jeżeli nie istnieją wstawia puste wartości). 

 
c) Left – zwraca wszystkie wiersze z drugiej tabeli i odpowiedniki z pierwszej jeżeli istnieją (jeżeli 

nie istnieją wstawia puste wartości). 

 
d) Full – zwraca wszystkie wartości z obu tabel (jeżeli nie istnieją odpowiedniki wstawia puste 

wartości). 

Narzędzie RELATES programu ArcMap w przeciwieostwie do JOIN nie łączy tabel a definiuje jedynie 

informację o związku. Stosowane jest do związków wiele-do-wielu i jeden-do-wielu. Powiązane 

tabele nie są wyświetlane łączenie, ale możliwy jest bezpośredni dostęp do atrybutów powiązanych. 

Dodad należy, że łączenie tabel w systemach GIS opierad się może zarówno na atrybutach opisowych 

jak i na relacji przestrzennej między obiektami (np. sąsiedztwie, odległości itp.).  

1.5 Praca wielodostępowa – pojecie transakcji 

Przewagą systemów bazodanowych nad pracą w systemie plików jest możliwośd jednoczesnego 

korzystania z zasobów bazy przez wielu użytkowników. Zapewnienie spójności danych w tym 

przypadku wymaga ograniczeo w dostępie do aktualnie modyfikowanych wartości w bazie. Zapewnia 

to mechanizm transakcji. Ten sam mechanizm chroni bazę na wypadek usterek lub przerw 

w zasilaniu. Ogólnie rzecz biorąc mechanizm transakcji zapewnia przeprowadzenie operacji edycji lub 

kwerendy modyfikującej do bazy w obszarze tymczasowym i po pomyślnym wykonaniu czynności  

w tym obszarze i zatwierdzeniu operacji - trwałego zapisu w bazie. Np. rozpoczęcie edycji geometrii 

istniejącego obiektu typu budynek przez jednego z użytkowników rozpoczyna transakcję a po 

pomyślnym zakooczeniu edycji i zatwierdzeniu kooczy ją co powoduje zapis w bazie i blokadę 

dostępu do obiektu tylko na tę chwilę.  Dzięki izolacji transakcji jeżeli jedno z poleceo składowych 

transakcji się nie powiedzie – cała transakcja jest wycofana i nie powoduje niespójności w bazie 

danych. 

1.6 Architektura systemów GIS 

Pod ogólnym pojęciem architektury systemu informatycznego rozumiemy sposób jego organizacji. 

W przeszłości najprostszą formą organizacji było rozwiązanie typu desktop GIS, którego zastosowanie 

umożliwiało gromadzenie i przetwarzanie danych na dysku komputera wyposażonego 

w specjalistyczne oprogramowanie. 
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Dalszy rozwój spowodował powstanie architektury dwuwarstwowej typu klient – serwer (rys. 3). 

Stworzyło to możliwośd jednoczesnego korzystania z usług systemu komputerowego przez wielu 

użytkowników. Wielodostęp umożliwił zasilanie bazy oraz edycję danych przez wielu operatorów 

systemów GIS równocześnie.  Wraz z rozwojem Internetu pojawiły się architektury wielowarstwowe 

(rys. 4). Model wielowarstwowy wprowadza do architektury dwuwarstwowej dodatkowy serwer 

pośredniczący zwany serwerem aplikacji lub warstwą pośrednią. Wydzielenie warstwy pośredniej 

powoduje odciążenie aplikacji będącej klientem. 

 

Rys. 3. Dwuwarstwowa architektura systemów GIS (Gotlib i inni, 2007) 

 

Rys. 4. Wielowarstwowa architektura systemów GIS (Gotlib i inni, 2007) 

Sposób organizacji Systemów informatycznych pozwalający różnym aplikacjom na wzajemne 

korzystanie ze swoich funkcji i wymianę informacji jest nazywany architekturą zorientowaną na 

usługi sieciowe (Service-Oriented Architecture, SOA).  Dobór oraz łączenie funkcji zwane kompozycją 

może prowadzid do powstania nowej usługi. 

Rozszerzenie usług o funkcje dotyczące informacji przestrzennej przez OGC (Open Geospatial 

Consortium) doprowadziło do powstania usług udostępniających dane on-line. Należą do nich m.in.: 

 WMS (Web Map Service) – serwis służący do udostępniania danych przestrzennych w postaci 
map w formacie rastrowym w określonym układzie współrzędnych i o zadanym rozmiarze. 
Pozwala na złożenie mapy zawierającej różne warstwy tematyczne pochodzące 
z niezależnych serwerów od różnych dostawców, 

 WFS (Web Feature Service) – serwis służący do udostępniania danych w postaci wektorowej 
w formacie GML (Geography Markup Language). Poprzez serwis WFS klient ma możliwośd 
selekcji danych według założonych kryteriów i zainteresowao, 

 WCS (Web Coverage Service) – stanowi rozszerzenie specyfikacji WMS. Odnosi się on do 
ciągłych danych przestrzennych posiadających określoną wartośd dla każdego piksela, np. 
dane o pokryciu terenu, dane o wysokościach terenu, itp. 
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2. Metody wizualizacji danych w systemach GIS 

2.1 Pojęcie mapy. Klasyfikacja map 

Mapa (def.wg Międzynarodowej Asocjacji Kartograficznej, 1990 r.) - jest modelem wybranego 

aspektu rzeczywistości geograficznej i zarazem narzędziem do przedstawiania informacji 

geograficznej w sposób, który może byd wzrokowy, cyfrowy lub dotykowy. 

Współcześnie mapa powstaje najczęściej jako kartograficzna wizualizacja treści bazy danych 

przestrzennych, stąd od poprawnego skonstruowania bazy danych (Rozdział I) zależy w dużej mierze 

możliwośd opracowania mapy poprawnie prezentującej dane zagadnienie *Olszewski, 2006+ 

Stosowane są różne kryteria klasyfikacji: 

 treśd,  

 skala, 

 przedstawiany obszar geograficzny, 

 forma prezentacji, 

 sposób wykorzystania. 

Do najważniejszych i najczęstszych kryteriów klasyfikacji należą: treśd i skala *Pasławski, 2006+. Ze 

względu na treśd mapy dzieli się na: ogólnogeograficzne i tematyczne. 

Mapy ogólnogeograficzne, jak sama nazwa wskazuje, dają ogólną charakterystykę obszaru 

prezentując najważniejsze elementy przestrzeni: ukształtowanie terenu, wody, pokrycie terenu, 

osiedla, linie komunikacyjne itp.  

Mapy tematyczne prezentują wybrane zagadnienia przyrodnicze i społeczno-gospodarcze. Treśd 

podkładu map tematycznych stanowią często niektóre elementy map ogólnogeograficznych (np. 

ukształtowanie terenu, rzeki, wybrane miasta itp.) 

Stosując kryterium skali mapy dzieli się na: 

 mapy wielkoskalowe, 

 mapy średnioskalowe, 

 mapy małoskalowe. 
Te kryteria nie są uniwersalne (różne dla map tematycznych i topograficznych). 

 

Rys. 5.  Klasyfikacja map do celów gospodarczych (na podst. Instrukcji tech.K-3) 
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2.2 Mapy środowiska przyrodniczego w Polsce 

Mapy poświęcone środowisku geograficznemu można podzielid na siedem grup tematycznych 

*Pasławski, 2006+: 

 Mapy geologiczne, 

 Mapy glebowe, 

 Mapy geomorfologiczne, 

 Mapy hydrograficzne, 

 Mapy roślinności, 

 Mapy klimatyczne, 

 Mapy sozologiczne, 

 Mapy pokrycia terenu i użytkowania ziemi. 

 
Tworzenie baz tematycznych oraz opracowanie na ich podstawie seryjnych map tematycznych w skali 

1 : 50 000 jest realizowane przez trzy instytucje: Paostwowy Instytut Geologiczny, Główny Urząd 

Geodezji i Kartografii oraz Instytut Meteorologii i Gospodarki Wodnej [Olszewski R. i in.,2007]. Bazy 

(mapy) te obejmą, lub już obejmują, powierzchnię całego kraju, a są to: 

 Mapa sozologiczna Polski (GUGiK), 

 Mapa hydrograficzna Polski (GUGiK), 

 Mapa geologiczno–gospodarcza Polski (PIG), 

 Mapa geośrodowiskowa Polski (PIG), 

 Mapa hydrogeologiczna Poslki (PIG), 

 Mapa podziału hydrograficznego Polski (IMGW). 

 
Mapa sozologiczna [Wytyczne techniczne GIS-4+ jest mapą tematyczną, przedstawiającą stan 

środowiska przyrodniczego oraz przyczyny i skutki – tak negatywnych, jak i pozytywnych – przemian 

zachodzących w środowisku pod wpływem różnego rodzaju procesów, w tym przede wszystkim 

działalności człowieka, a także sposoby ochrony naturalnych wartości tego środowiska. 

Na treśd tematyczną mapy składają się następujące grupy elementów, uszeregowane w kilku 

poziomach informacyjnych: 

1. Formy ochrony środowiska przyrodniczego, m.in.: 

 grunty orne chronione i pozostałe oraz łąki i pastwiska chronione i pozostałe, lasy 
ochronne i pozostałe i inne, 

 parki narodowe i parki krajobrazowe oraz ich otuliny, rezerwaty i pomniki przyrody 
oraz obszary chronionego krajobrazu. 

 
2. Degradacja komponentów środowiska przyrodniczego, m.in.: 

 degradacja powierzchni terenu,  

 typy gleb zdegradowanych, 
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 czynniki i klasy uszkodzeo lasów, 

 degradacja wód powierzchniowych,  

 degradacja wód podziemnych,  

 degradacja powietrza atmosferycznego. 

 
3. Przeciwdziałanie degradacji środowiska przyrodniczego (urządzenia odpylające i 

odsiarczające, oczyszczalnie ścieków, pasy wiatrochronne, ekrany akustyczne i inne). 

4. Rekultywacja środowiska przyrodniczego (formy rekultywacji). 

5. Nieużytki (typy nieużytków). 

2.3 System odniesienia, odwzorowania i układy współrzędnych 

Jednym z warunków poprawnego opracowania map jest stosowanie reguł matematycznych, których 

wyraz stanowi odwzorowanie kartograficzne, pozwalające przedstawid powierzchnię Ziemi na 

płaszczyźnie. 

System odniesienia -  określa geometryczne i geofizyczne parametry Ziemi (m.in. długośd półosi i 

spłaszczenie ziemskie elipsoidy) 

Odwzorowanie kartograficzne – umowny, określony matematycznie, sposób przyporządkowania 

punktom powierzchni kuli (elipsoidy) punktów na płaszczyźnie 

Układ współrzędnych pozwala na określenie położenia dowolnego punktu na kuli (układ 

współrzędnych geograficznych/geodezyjnych) bądź płaszczyźnie (układ współrzędnych prostokątnych 

płaskich). 

Obecnie w Polsce obowiązuje system odniesieo przestrzennych wprowadzony do stosowania 

rozporządzeniem Rady Ministrów z dnia 08.08.2000r. w sprawie paostwowego systemu odniesieo 

przestrzennych. 

System ten tworzą:  

1. geodezyjny układ odniesienia EUREF-89 oparty o Geodezyjny System Odniesienia GRS 80 

określający parametry geometryczne i fizyczne Ziemi  

2. układ wysokości, w którym wyznacza się wysokości punktów względem średniego poziomu 

Morza Bałtyckiego w Zatoce Fioskiej, wyznaczonego dla mareografu w Kronsztadzie.  

3. układ współrzędnych płaskich prostokątnych, oznaczony symbolem "2000": 

 stosowany w pracach geodezyjnych i kartograficznych związanych z opracowaniem 
mapy zasadniczej, 

 równokątne odwzorowanie Gaussa-Krügera 

 dla obszaru Polski wyodrębniono cztery trzystopniowe strefy południkowe o 
południkach osiowych, których długości geograficzne wschodnie wynoszą 15 °, 18 °, 21 
° i 24 ° 
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 dla każdej z tych stref współczynnik zmiany skali w południku osiowym wynosi 
0.999923.  

4. układ współrzędnych płaskich prostokątnych, oznaczony symbolem "1992": 

 stosowany w mapach urzędowych o skali 1 : 10 000 lub mniejszej 

 równokątne odwzorowanie Gaussa-Krügera  

 dla obszaru Polski przyjęto jedną strefę o południku osiowym 19° E 

 współczynnik zmiany skali w tym południku wynoszącym 0.9993. 

2.4 Charakterystyka zjawisk przestrzennych 

Dane przestrzenne są podstawowymi składnikami, faktami dotyczącymi środowiska przyrodniczego. 

Tym najmniejszym elementem jest pojedyncza dana, łącząca miejsce, często czas oraz jakąś 

opisywaną cechę (atrybut) *Longley P.A., Goodchild M.F. i in,2006+ 

Dane przedstawiane na mapie mogą byd wyrażone na różnych tzw. poziomach pomiarowych. Pojęcie 

pomiaru - wprowadzone przez Stevensa – oznacza przyporządkowanie obiektom liczb (miar) zgodnie 

z regułami odzwierciedlającymi relacje pomiędzy tymi obiektami *Pasławski+. Wyróżnia się cztery 

skale pomiaru danych: 

1. nominalna: jedyne relacje pomiędzy obiektami, jakie można określid to relacje podobieostwa 

czy różności. Służy do identyfikacji lub odróżniania obiektów. 

Przykład danych wyrażonych w skali nominalnej: droga, typ gleby-czarnoziem; kategoria 

użytkowania gruntów: grunt orny, pastwisko etc. 

2. porządkowa: pozwala na uporządkowanie danych. Na tym poziomie można stwierdzid, że 

poszczególne obiekty są mniejsze lub większe, bardziej lub mniej „ważne”, ale nie można 

określid ich konkretnych wartości ani różnic pomiędzy nimi. 

Przykład danych: klasy bonitacyjne, klasy czystości rzek etc. 

3. interwałowa: skala ilościowa, w której dane mierzone są od zera względnego. Można określid 

„o ile” jeden obiekt jest większy/mniejszy od innego. 

4. ilorazowa: skala ilościowa, w której dane mierzone są od zera bezwzględnego. W odróżnieniu 

od skali interwałowej, można tutaj określid stosunek liczbowy między obiektami („ile razy”). 

 

Tabela 2. Skale pomiarowe zjawisk i ich właściwości 

Skala pomiarowa Działania matematyczne Najbardziej odpowiednia średnia 

Nominalna =, ≠ moda 

Porządkowa =, ≠, <, > mediana 

Interwałowa =, ≠, <, >, +, - średnia arytmetyczna 

Ilorazowa =, ≠, <, >, +, -, x, ÷ średnia arytmetyczna 
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A. Podział ze względu na wymiar: 

 zerowymiarowe (punkt), np. miasto, drzewo, etc. (*) 

 jednowymiarowe (linia), np. rzeki, drogi, etc. 

 dwuwymiarowe (powierzchnia), np. użytkowanie terenu (lasy, grunty orne),wody stojące,  
zabudowa gęsta wielorodzinna, etc. 

 (*) przyporządkowanie obiektu do danej kategorii zależy od skali mapy 

B. Podział ze względu na sposób występowania w rzeczywistości: 

 zjawiska ciągłe, np. wysokośd n.p.m.,  

 zjawiska dyskretne, np. lotnisko, miasto, 

 zjawiska częściowo-ciągłe (liniowe, wyspowe), np. drogi, obszary chronione. 

C. Podział ze względu na sposób ujęcia: 

 bezwzględne są wynikiem pomiarów lub obserwacji bezpośrednich. Wyrażone są w: tonach, 
ha, zł,  osobach, sztukach, dniach, 

 względne będące wynikiem przeliczeo. Są to np. średnie, relacje (przedstawiające stosunki, 
takie jak proporcje, procenty), gęstośd, itp. 

2.5 Symbolizacja danych: zmienne graficzne, znaki kartograficzne 

Zmienne graficzne 

Zmienne graficzne, nazwane też wizualnymi, są swoistym „alfabetem graficznym” *Pasławski, 2006+. 

Umożliwiają one przedstawienie, oprócz lokalizacji (współrzędne x,y płaszczyzny mapy), trzeciego 

wymiaru, który odpowiada graficznej prezentacji charakterystyki zjawiska (jakościowej, porządkowej, 

ilościowej). 

Wyróżnia się sześd zmiennych wizualnych (wg Bertina): kształt, wielkośd, jasnośd (walor), ziarnistośd, 

kolor, orientacja. 

Znaki kartograficzne 

Podstawowym celem mapy jest dostarczanie informacji o obiektach i zjawiskach geograficznych. Te 

informacje przekazywane są za pomocą umownych znaków graficznych, nazywanych znakami 

kartograficznymi. Każdy znak kartograficzny ma określoną formę graficzna i przedstawia treśd, która 

odpowiada jego znaczeniu podanemu w legendzie mapy *Pasławski, 2006+. 

Znaki kartograficzne mają ścisły związek z podziałem zjawisk ze względu na wymiar i wyróżnia się: 

 znaki powierzchniowe (przede wszystkim zaznacza się obiekty i zjawiska występujące w 
sposób ciągły lub wyspowy), 

 znaki liniowe (przede wszystkim takie obiekty, jak drogi, koleje, rzeki), 
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 znaki punktowe (przedstawia się obiekty, których rozmiary nie pozwalają na czytelne 
przedstawienie za pomocą linii konturu lub znaku powierzchniowego). 

 

Rys. 6. Fragmenty mapy topograficznej w skali 1 : 10 000 

2.6 Modele danych w GIS. Model krajobrazowy a model kartograficzny 

Model danych jest uporządkowanym cyfrowym opisem służącym do reprezentacji wybranych cech 

świata rzeczywistego (Longely i in.2006). Dwa podstawowe sposoby modelowania przestrzeni 

geograficznej w systemach GIS to: 

 model wektorowy – właściwy dla danych o charakterze dyskretnym lub częściowo ciągłym, 

 model rastrowy – właściwy dla danych o charakterze ciągłym. 

 
Model przestrzeni geograficznej, w zależności od sposobu i celu jego tworzenia, może byd zapisany 

jako model [Olszewski, 2007]: 

 model obrazowy, 

 model krajobrazowy DLM (ang. Digital Landscape Model), 

 model kartograficzny DCM (ang. Digital Cartographic Model). 
Model krajobrazowy DLM – to model bazodanowy, który powstaje na podstawie wektoryzacji 

elementów modelu obrazowego (np. zdjęd lotniczych) lub przez pomiar bezpośredni w terenie. W 

modelu tym poszczególne obiekty zachowują ścisłą georeferencję (odniesienia przestrzenne), ich 

położenie i kształt nie są modyfikowane podczas redakcji kartograficznej. Pozwala to na pełne, 

precyzyjne zachowanie topologicznych własności obiektów oraz tworzenie struktur danych, takich jak 

„drzewa” i „sieci” *Olszewski i in., 2007+. 

Model kartograficzny DCM – powstaje poprzez redakcję modelu DLM: nadanie symboliki 

kartograficznej, wygładzanie linii, przesunięcia obiektów, generowanie i obróbka rysunku 

warstwicowego. Model ten przekazuje informacje o obiektach za pomocą ustalonych konwencji 

graficznych – opisanych wcześniej znaków kartograficznych *Olszewski i in., 2007+. 
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2.7 Klasyfikacja danych  

Warunkiem prawidłowego podziału danych na klasy jest minimalizowanie różnic wartości w obrębie 

klas przy jednoczesnym maksymalizowaniu różnic między klasami. Skutkuje to tym, że granice klas 

widoczne na mapie będą zgodne z granicami w rzeczywistości. 

Metody podziału danych na klasy (*) 

A. Klasy o jednakowej rozpiętości: 

- wartości (Równe interwały/Equal Interval), 

- liczby obserwacji (Kwantyle/Quantile), 

- odchylenia standardowego (Standard Deviation), 

- wg postępu arytmetycznego, 

- wg postępu geometrycznego (Geometrical Interval). 

B. Klasy o nieregularnej rozpiętości: 

- podział na podstawie wykresu (odpowiednik Natural Breaks), 

- metoda średnich częściowych. 

(*) w nawiasie podano nazwy stosowane w programach GISowych 

 

Rys. 7. Przykładowe metody podziału danych na klasy zaimplementowane w programach ArcGIS (A)  i GeoMedia (B) 
(Opracowanie własne) 
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2.8 Charakterystyka wybranych metod kartograficznych 

Prezentacje kartograficzne to zastosowanie na mapie odpowiednio dobranych znaków 

kartograficznych, których cechy graficzne są ściśle skorelowane z cechami prezentowanych danych. 

Pozwala to przypisad znakom kartograficznym znaczenie nominalne lub ilościowe, zaś wzajemne ich 

rozmieszczenie na mapie oddaje relacje przestrzenne zachodzące pomiędzy prezentowanymi 

obiektami i zjawiskami. 

Wyróżniamy osiem metod prezentacji danych [Instrukcja techniczna K-3]: 

1. Metoda sygnaturowa  
2. Metoda zasięgów  
3. Metoda powierzchniowych jednostek odniesienia  
4. Metoda kartodiagramu 
5. Metoda kropkowa 
6. Metoda kartogramu 
7. Metoda izolinii 
8. Metoda dazymetryczna 

Metody ilościowe:  

A. dla danych bezwzględnych 

- metoda kartodiagramu 
- metoda kropkowa 
- metoda izolinii 
 

B. dla danych względnych: 

- metoda kartodiagramu 
- metoda kartogramu 
- metoda dazymetryczna 
- metoda izolinii 
 

Poniżej przybliżone zostaną wybrane metody, które będą wykorzystywane do opracowania map w 

trakcie dwiczeo. Bardziej szczegółową charakterystykę wszystkich metod można znaleźd w podanych 

pozycjach literatury. 

Metoda kartodiagramu 

Jest to metoda przedstawienia na mapie przestrzennego rozmieszczenia zjawisk w ujęciu 

bezwzględnym i względnym, odniesionych do punktu, linii i powierzchni za pomocą wykresów, 

diagramów, których rozmiary są proporcjonalne do wielkości zjawiska lub wyrażają funkcję jego 

zmienności. 

Metody jakościowe 

Metody ilościowe 
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Rys. 8. Kartodiagram prosty w skali skokowej (Opracowanie własne) 

 

Rys. 9. Kartodiagram złożony w skali ciągłej (Opracowanie własne) 

Metoda kartogramu 

Metoda kartogramu pozwala na przestrzenną lokalizację danych ilościowych względnych, 

odniesionych do powierzchni, wyrażonych w skali skokowej. Natężenie zjawiska może byd 

przedstawione przy użyciu zmiennej wizualnej walor (najodpowiedniejsza zmienna).  
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Rys. 10. Kartogram prosty (zmienna wizualna – walor) (Opracowanie własne) 

 

 

Rys. 11. Kartogram odchylenia od średniej (Opracowanie własne) 

Metoda dazymetryczna posiada cechy kartogramu: relatywne ujęcie danych, zgrupowanie ich w 

przedziały klasowe i powierzchniowe jednostki odniesienia, które w przypadku kartogramu są z góry 

założone, natomiast w mapie dazymetrycznej wynikają ze zmienności samego zjawiska. Uwolnienie 

się od określonych jednostek odniesienia (zazwyczaj administracyjnych) sprawia, że rozmieszczenie 

natężenia zjawiska jest zgodne z jego geograficznym, rzeczywistym rozmieszczeniem. Kartogram 

dazymetryczny cechuje większa szczegółowośd i mozaika pól. 
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Rys. 12. Mapa dazymetryczna (jednostka odniesienia – sied pól o wymiarach 1kmx1km)  (Opracowanie własne) 

Obecne na rynku oprogramowanie GISowe zapewnia szerokie możliwości wizualizacji danych różnym 

metodami kartograficznymi, których efektem będą poprawne merytorycznie i praktycznie użyteczne 

mapy tematyczne tylko wtedy, gdy użytkownik zna zasady tworzenia map wybranymi metodami. 

Musi posiadad on wiedzę na temat skal, w jakich wyrażone są zjawiska, charakteru obiektów, do 

których dane mogą byd odniesione, znad rodzaje zmiennych wizualnych, techniki podziału danych na 

klasy, a także możliwości połączeo różnych metod w wyniku czego powstają mapy dwu- lub wielo-

zmienne.  

3. Operatory i analizy przestrzenne 

Dwa podstawowe modele danych przestrzennych, wektorowy i rastrowy, posiadają swoje zestawy 

narzędzi do wykonywania analiz. Oczywiście w czasie wykonywania analiz można wykorzystywad 

jednocześnie dane zapisane w obu modelach, wykorzystując narzędzia konwersji z danych 

wektorowych na rastrowe i odwrotnie.  

3.1 Analiza danych wektorowych 

Najprostsze analizy danych wektorowych odnoszą się do ich części opisowej (atrybutowej). 

W celu wykonania zapytao należy wybrad z menu Selection opcję Select By Attributes (Selekcja 

atrybutowa).  Należy określid z jakiej warstwy chcemy wybrad obiekty oraz wskazad metodę. 

Dostępne są cztery metody:  

 Create  a new selection (Stwórz nową selekcję) 

 Add to current selection (Dodaj do istniejącej selekcji) 

 Remove from current selection (Usuo z istniejącej selekcji) 

 Select from current selection (Wybierz z isniejącej selekcji) 



 
 
 

29 

Następnie trzeba wskazad zestaw atrybutów i ich wartości, które posłużą do selekcji.  

Przydatnym przyciskiem jest Get Unique Values (Pobierz unikalne wartości), który  pokazuje wszystkie 

dostępne wartości wybranego atrybutu.  

Poniższe przykłady pokazują w jaki sposób mogą byd konstruowane takie zapytania. 

 

"NAZ" = 'Aleksandrów' – znajdź miejscowośd 
Aleksandrów 
"NAZ" LIKE 'M%' – znajdź wszystkie 
miejscowości zaczynające się na literę M 
"POP" IS NOT NULL – znajdź wszystkie 
miejscowości, które mają podaną liczbę 
ludności (atrybut POP – populacja nie jest 
pusty)  
"POP" >= 5000 – znajdź miejscowości o 
populacji powyżej 5000 osób 
"POP" / "AREA" <= 300 – znajdź miejscowości o 
gęstości zaludnienia poniżej 300 osób na 
jednostkę powierzchni. 
"POP" > 1500 AND "AREA" > 3 – znajdź 
miejscowości o populacji powyżej 1500 osób i 
jednocześnie  powierzchni powyżej 3 
(ustawionych jednostek np. km kw) 
"POP" > 1500 OR "AREA" > 3 – znajdź 
miejscowości o populacji powyżej 1500 osób 
lub powierzchni powyżej 3 (ustawionych 
jednostek np. km kw) 
"NAZ" NOT IN (SELECT "NAZ" FROM 
miejsc_point WHERE "NAZ" LIKE 'W%') – znajdź 
miejscowości których nazwy nie zaczynają się 
od litery W 

 

Drugim z podstawowych narzędzi analizy danych wektorowych jest Select By Location (selekcja 

przestrzenna, przez lokalizację), który pozwala na definiowanie zależności przestrzennych między 

obiektami różnych warstw. W tym narzędziu można wybrad obiekty więcej niż jednej warstwy w 

zależności od relacji przestrzennej do (wybranych lub wszystkich) obiektów zaznaczonej niżej 

warstwy lub jej części (nazwijmy te obiekty roboczo „bazowymi”). 

Z relacjami przestrzennymi łączy się pojęcie operatorów przestrzennych. W różnych systemach używa 

się różnorodnego nazewnictwa (zestawienie poniżej), jednak w ostatnich latach można zauważyd 

daleko idące ujednolicenie pojęd. Na poniższym rysunku przedstawiono sposób wyboru operatora 

przestrzennego.  
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Relacje przestrzenne w różnych systemach (na podstawie Makowski A. i in., 2005): 

 Freeman: left of (na lewo), right of (na prawo), above (powyzej), below (poniżej), near (w 

poblizu), far (daleko), touching (dotyka), between (pomiędzy), inside (wewnątrz), outside (na 

zewnątrz),  

 ATLAS: area adjacency (obszary przyległe), line adjacency (odcinki Iinii przyległe). boundary 

relationship (relacje między granicami), distance (odległośd)’ direction (kierunek),  

 MAPQUERY: on (na), adjacent (przyleganie), within (wewnątrz),  

 KBGIS: containment (obejmuje) neighborhood (sąsiaduje), near (w pobliżu), far (daleko), 

north (północ), south (południe), east (wschód), west (zachód); distance (odległośd), overlay 

(pokrywa), adjacent (przylega), overlap (zachodzi na), 

 PSQL: covering (przykrywa), covered by (przykrywane przez), overlapping (zachodzi na), 

disjoint (rozłączne), nearest (blisko), furthest (najdalszy), within (wewnątrz), outside (na 

zewnątrz), on perimeter (na obwodzie),  

 SQL extension: adjacent (przylega), contains (zawiera), contains point (zawiera punkt), 

enclosed by (zamknięty), intersect (przecinanie), near (w pobliżu). self intersect (przecinanie 

wzajemne),  

 Spatial SQL: overlap (nakładanie), concur (zbiegad się), common bounds (wspólne granice),  

 Georelational Algebra: equal (równośd), not equal (nierównośd). inside (wewnątrz). outside 

(na zewnątrz), intersect (przecinanie). 
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3.2 Operatory przestrzenne (na przykładzie ArcGIS) 

Rysunki w tym podrozdziale stanowią opracowanie własne autora. 

Obiekty bazowe, w stosunku do których wykonuje się wyszukiwanie oznaczone są kolorem 

czerwonym, natomiast wyniki działania operatora kolorem jasnoniebieskim. 

Intersect (Przecięcie) operator mający najszersze działanie. 
Znajduje obiekty, które stykają się przynajmniej jednym 
punktem. 
 
 
 
 
 
 

 

 

Are within a distance of (w odległości) - operator 

wyszukujący wszystkich obiektów leżących w 

podanej odległości od obiektów “bazowych”. 

Wystarczy jeden punkt, leżący w odpowiedniej 

odległości, aby cały obiekt został zwrócony w 

odpowiedzi.  

 

 

 

 

 

Completely contain (całkowicie zawiera) – 

operator  wyszukuje obiekty, które całkowicie 

zawierają wewnątrz siebie obiekty bazowe. 

Oznacza to, że obiekty bazowe nie mogą w żadnym 

punkcie dotykad obiektów wyszukiwanych. 

Przykładowo: posiadamy dwie warstwy: 

Województwa i Paostwa, obiektem bazowym jest 

„województwo łódzkie”. W odpowiedzi otrzymamy 

obiekt „Polska” z warstwy Paostwa. Jeżeli 

natomiast obiektem bazowym będzie „województwo podlaskie” odpowiedzią będzie zbiór 

pusty, dlatego, że obiekt ten dotyka granic z warstwy Paostwa. 
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Contain (zawiera) -  operator  wyszukuje 

obiekty, które zawierają wewnątrz siebie 

obiekty bazowe. Różnica w stosunku do 

poprzedniego operatora przestrzennego jest 

taka, że obiekty bazowe mogą się stykad 

jednym lub więcej punktami, ale tylko od 

wewnątrz. 

 

 
 

Contain (Clementini) (Zawiera - Clementini) - 

Operator zwraca podobne wyniki jak Contain. 

Jedyna różnica polega na tym, że jeśli istnieje 

obiekt bazowy, który leży tylko na granicy 

obiektu szukanego, i nie ma żadnej swojej części 

wewnątrz, powoduje odrzucenie takiego 

obiektu szukanego. 

 

 
 

Are completely within (jest całkowicie zawarty) – w 

tym przypadku następuje zmiana perspektywy i 

szukane są obiekty całkowicie zawarte w obiektach 

bazowych.  

 

 

 
 
 
 

 
Are within  - (jest zawarty) – operator wyszukuje 

obiekty zawarte w obiektach bazowych. Mogą 

one od wewnątrz się z nimi stykad w jednym lub 

więcej punktów. 
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Are Within (Clementini) (jest zawarty - Clmentini) – 

operator działa podobnie jak Are within. Różnica jest taka, 

że obiekt leżący jedynie na granicy obiektu bazowego nie 

jest zwracany w wyniku. 

 

 

 

 

 

Have their centroid in (ma centroid wewnątrz) – 

operator zwraca obiekty, które posiadają swój 

centroid wewnątrz lub na granicy obiektów 

bazowych.  

 
 
 
 
 
 

 
 

  Share a line segment with (współdzieli segment 

linii) – operator znajduje obiekty mające wspólne co 

najmniej dwa sąsiadujące werteksy (werteksy to 

punkty charakterystyczne – załamania granicy 

obiektu powierzchniowego lub linii, kooce linii, 

środki odcinków). Dotyczy to tylko obiektów 

liniowych i powierzchniowych. 

{ 

Touch the boundary of (Dotyka granicy)  - operator jest 

przeznaczony jedynie dla obiektów liniowych 

i powierzchniowych. Aby obiekt znalazł się wśród 

wynikowych, musi spełniad następujące warunki: 

przecięcie granicy badanych obiektów musi byd niepuste, 

a jednocześnie przecięcie ich wnętrz musi byd puste. Jest 

jednak wyjątek: obiekt zostanie zwrócony jeśli jest zawarty 

(operator within) w obiekcie bazowym i ma przynajmniej 

jeden punkt wspólny z jego granicą. 



 
 
 

34 

 

Are identical to (jest identyczny z) – operator 

zwraca obiekty, które są identyczne pod 

względem kształtu i położenia. Oznacza to, że 

porównywad można jedynie obiekty tego 

samego typu geometrycznego. Działa na 

obiektach powierzchniowych liniowych i 

punktowych. 

 

 

Are crossed by the outline of (Przecina granicę) – aby operator 

zwrócił w wyniku obiekty muszą mied wspólny przynajmniej jeden 

werteks, jeden punkt przecięcia się granic lub jeden punkt koocowy 

ale jednocześnie nie mogą mied wspólnej krawędzi. Operator działa 

na obiektach liniowych i powierzchniowych. 

 
 

3.3 Narzędzia Analiz (na przykładzie ArcGIS) 

W narzędziach Toolbox-a znajduje się zastaw pod nazwą Analysis Tools (Narzędzia Analiz). Poniżej 

przedstawiono wszystkie narzędzia z tego zestawu, właściwe dla licencji ArcView. 

Extract Tools (Narzędzia ekstrakcji) 

Clip (Wycięcie) 

Obiekt Clip “wycina“ z klasy obiektów wejściowych (Input) obiekty i ich części, które się z nim 

pokrywają. 

 
 klasa ob. wejściowych   obiekt wycinający         rezultat    
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Select (Selekcja) 

Polecenie,  które za pomocą zapytania atrybutowego (składnia SQL) wybiera obiekty ze wskazanej 

klasy obiektów i umieszcza je w nowej klasie obiektów. 

Table select (Selekcja tabelaryczna) 

Selekcjonuje rekordy za pomocą zapytania atrybutowego z wybranej tabeli i umieszcza je w nowej 

tabeli 

Overlay Tools (Narzędzia nakładania) 

Intersect  (Przecięcie) 

Polecenie przecięcia znajduje wspólną częśd z dwu warstw i zapisuje wynik w nowej klasie obiektów. 

W wyniku łączone są też atrybuty opisowe warstw wejściowych.  

 
                     obiekty źródłowe                                                               wynik 
  

Spatial Join (Złączenie przestrzenne) 

Narzędzie pozwalające na przestrzenne łączenie obiektów oraz ich atrybutów. Przykładowo 

posiadamy obiekty punktowe i chcemy uzyskad informację o tym w jakich jednostkach 

administracyjnych one leżą, narzędzie Spatial Join pozwoli przypisad tym obiektom atrybuty 

odpowiednich jednostek. 
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Union (Unia - Scalenie) 

Narzędzie, które tworzy kombinację wszystkich wejściowych warstw pod względem geometrycznym 

oraz atrybutowym. Wynik zapisywany jest w nowej klasie obiektów.  

 

 
               obiekty źródłowe                                                                    wynik 

 

Proximity (Narzędzia analiz bliskości ) 

Buffer (Bufor) 

 
 

Tworzy strefę buforową z granicą na zadanej odległości od obiektów. 

Wewnętrzna częśd obiektu także należy do bufora. 

 

 

Multiple Ring Buffer (Bufor wielopierścieniowy) 

 

Tworzy wiele buforów na zadanych przez użytkownika 

odległościach. 
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Statistics (Statystyki) 

Summary Statistics (Główne statystyki) 

Podaje podstawowe statystyki dla danych atrybutowych zawartych w tabelach.  

3.4 Analiza danych rastrowych 

Rastrowy model danych pozwala na analizę zjawisk występujących w sposób ciągły. Przykładami 

mogą byd: głębokośd wód podziemnych, wysokośd terenu n.p.m., zawartośd zanieczyszczeo w glebie, 

temperatura itd.  

Każda komórka w modelu rastrowym ma przypisaną wartośd. Dla numerycznego modelu ternu 

będzie to wysokośd, dla zanieczyszczeo wielkośd fizyczna wyinterpolowana z wykonanych próbek. W 

komórkach można też zapisywad inne wartości, takie jak odległośd od wybranych obiektów. 

Charakter tego typu modelowania powoduje, że każdą zaprojektowaną analizę można potraktowad 

jako nowe narzędzie. W rozszerzeniu Spatial Analyst zdefiniowanych jest kilkadziesiąt najczęściej 

stosowanych narzędzi analizy modelu rastrowego. Mogą one służyd do budowy bardziej złożonych 

analiz. W kolejnym podrozdziale przedstawiono wybrane narzędzia. 

3.5 Wybrane narzędzia analiz rastrowych 

 

Con (warunkowanie) 

Con(RASTER1 > 5, 100, 50) 

Jeśli warunek polegający na tym, że wartośd komórki (w RASTER1) jest większa niż 5 jest spełniony to 

w rastrze wynikowym w tej komórce wpisana zostanie wartośd 100; jeśli ten warunek nie jest 

spełniony, wartośd wpisana będzie wynosiła 50. 

 Con(RASTER1 > 5, RASTER1, 50) 

Jeśli warunek polegający na tym, że wartośd komórki (w RASTER1) jest większa niż 5 jest spełniony to 

w rastrze wynikowym w tej komórce zostanie przepisana dokładnie taka sama wartośd jak 

poprzednio; jeśli ten warunek nie jest spełniony, wpisana będzie wartośd 50. 

Reclassify (reklasyfikacja), funkcja której działanie polega na przypisaniu nowych wartości w miejsce 

podzielonych na przedziały danych wejściowych. 
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Zasada działania funkcji reklasyfikacji 

 
Rysunek został pobrany ze strony http://ocean.ug.edu.pl/~oceju/giswbp.htm i użyty za uprzejmą zgodą jego twórcy, 

prof. Jacka Urbańskiego, autora książki „GIS w badaniach przyrodniczych”. 

 
 

Map Algebra (Algebra mapy), pozwala na wykonywanie operacji algebraicznych pomiędzy rastrami. 

W poniższym przykładzie w punkcie a) nastąpiło przemnożenie rastra reprezentującego głębokośd 

jeziora przez 4 (przyjęta powierzchnia komórki). W ten sposób uzyskany został raster objętości jeziora 

(tutaj nazwany jako nowy_raster). W punkcie b) raster głębokości został przemnożony przez raster 

stężenia hipotetycznego zanieczyszczenia. W ten sposób otrzymano raster z oszacowaną wielkością 

zanieczyszczeo. Jest to oczywiście bardzo uproszczony model, ale doskonale oddaje on zasadę 

wykorzystania algebry mapy. 

 
Przykład zastosowania algebry mapy. 

Rysunek został pobrany ze strony http://ocean.ug.edu.pl/~oceju/giswbp.htm i użyty za uprzejmą zgodą jego twórcy, 

prof. Jacka Urbańskiego, autora książki „GIS w badaniach przyrodniczych”. 
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Euclidean distance (odległośd euklidesowa) wyznaczana jest dla każdej komórki rastra osobno w 

stosunku do wskazanych przez użytkownika obiektów. 

 
Działanie funkcji odległości euklidesowej (Opracowanie własne). 

Slope (Nachylenia) – narzędzie obliczania nachylenia stoków. Wartości mogą byd otrzymywane w 

stopniach lub procentach. 

 

 
Mapa nachyleo(Opracowanie własne). 

Aspect (Ekspozycja) - narzędzie pokazujące skierowanie poszczególnych zboczy według ston świata. 

Można samodzielnie definiowad przedziały kątowe do przedstawienia na mapie. 
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Mapa ekspozycji (Opracowanie własne). 

Flow accumulation (akumulacja spływu) – wykonywany jest na podstawie określonych kierunków 

spływu. 

 

Mapa akumulacji spływu (Opracowanie własne). 

 

Geoprocessing (Geoprzetwarzanie). 

W systemie ArcGIS dostępne jest narzędzie ModelBuilder, które służy do budowania złożonych 

modeli analitycznych. Nastęuje to przez zestawienie połączonych ze sobą narzędzi analitycznych i 

podanie na wejście danych do przetworzenia. Pojęcie „model” oznacza, że po zdefiniowaniu całego 

procesu, można zmieniad parametry wejściowe modelu i sprawdzad, jaki to ma wpływ na uzyskiwane 

wyniki. W modelu można stosowad narzędzia analiz wektorowych, rastrowych, narzędzia zarządzania 

danymi oraz inne dostępne w ArcGIS. 
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Przykładowy model wykonany w ModelBuilderze (Opracowanie własne). 
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Ćwiczenia praktyczne 
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Ćwiczenie 1: Wprowadzenie do programu GeoMedia 

1. 1 Ogólna charakterystyka systemu 

 GeoMedia, produkt firmy INTERGRAPH© wprowadzony na rynek w 1997 r., stanowi otwarty, 

standardowy pakiet oprogramowania dla specjalistów z dziedziny GIS, umożliwiający integrację 

danych geograficznych z wielu źródeł, tworząc platformę dostępu i analiz do danych przestrzennych 

i opisowych. Zawiera on wiele zaawansowanych funkcji między innymi do tworzenia baz danych, do 

pozyskiwania i weryfikacji danych GIS, analiz, generowania map tematycznych i prezentacji. Dostępny 

jest również w wersji GeoMedia Professional rozszerzającej  funkcjonalnośd GeoMediów o funkcje do 

pozyskiwania, weryfikacji topologicznej, zarządzania i aktualizacji danych geograficznych. 

Funkcjonalnośd GeoMedia pozwala na integrację danych rozproszonych i pochodzących z różnych 

źródeł oraz daje możliwośd łatwego ich udostępniania . 

1.2 Integracja i zarządzanie danymi 

 GeoMedia pozwalają wizualizowad i analizowad dane z wielu baz w jednym środowisku bez 

konieczności ich importu. Technologia serwerów danych pozwala na bezpośredni dostęp do takich  

standardów, jak : MGE, MicroStation, AutoCad, ArcView, ArcInfo, MapInfo, FRAMME, Oracle9i, 

Microsoft SQL Server, Microsoft Access, IBM DB2, GML a także serwer plików danych tekstowych 

i ODBC. Oprogramowanie pozwala na stworzenie własnego projektu, którego dane graficzne 

i opisowe mogą byd zapisywane w bazie MS Access, Oracle (w modelu relacyjnym lub obiektowym), 

MS SQL Server lub IBM DB2. Dane przestrzenne z różnych projektów są dołączane do wspólnej 

przestrzeni geograficznej „GeoPrzestrzeni” i tam mogą byd wspólnie wyświetlane i analizowane. 

Dowolne informacje zapisane w pliku tekstowym, arkuszu kalkulacyjnym, zewnętrznych bazach 

danych oraz innych danych tabelarycznych ODBC, mogą byd połączone z danymi graficznymi 

i wykorzystywane do analiz przestrzennych i atrybutowych. GeoMedia pozwalają na wykorzystywanie 

danych rastrowych (zdjęcia lotnicze, satelitarne, skanowane mapy). Akceptowane są wszystkie 

formaty Intergraph (rle, cit, cot, rgb), TIFF,TIFF, JPG, hrf, CADRG i inne.  

1.3 Tworzenie geoprzestrzeni  

Geoprzestrzeo (ang. Geoworkspace) jest to przestrzeo robocza programu utożsamiana z projektem. 

Zapisywana jest jako plik o rozszerzeniu *.gws Każda GeoPrzestrzeo posiada określone 

odwzorowanie i układ współrzędnych. Zawiera między innymi informacje o źródłach danych i ich 

lokalizacji, stanie pracy, aktualnym widoku na dane, definicji i wyników zapytao oraz atrybutów 

wyświetlania obiektów. Geoprzestrzeo nie zawiera danych – te znajdują się w geohurtowniach. 

Uruchamiając program musimy wskazad roboczą geoprzestrzeo. Może to byd istniejąca 

geoprzestrzeo zapisana na dysku lub nowa. Nową geoprzestrzeo można tworzyd opcjonalne 

z pewnymi ustalonymi wcześniej ustawieniami zapisanymi w tzw. szablonie. 
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Aby utworzyd pustą geoprzestrzeo po uruchomieniu programu wybieramy opcję pusta 

geoprzesztrzeo w oknie wyboru: 

 

Spowoduje to uruchomienie programu z pustym oknem mapy. 

1.4 Podłączanie istniejącej bazy danych 

W celu nawiązania połączenia z serwerem (plikiem) zawierającym dane należy wybrad opcję 

Warehouse→New Connection: 

 

W oknie kreatora połączeo należy wskazad standard danych. W przypadku bazu danych BDO jest to 

standard Access. Następnie wskazujemy lokalizację pliku danych na dysku (Browse): 
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Wykonanie powyższych czynności umożliwi dostęp do danych we wskazanych lokalizacjach. Lista 

wszystkich połączeo do geoprzestrzeni znajduje się w poleceniu Warehouse→Connections. Narzędzie 

to pozwala zmienid tryb dostępu do danych oraz wykonad koleje połączenia: 

 

1.5 Praca z klasami obiektów w oknie mapy i tabeli. Rastry 

Aby wyświetlid w oknie mapy wybraną klasę obiektów należy wybrad opcję Legend→Add Legent 

Entries: 
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A następnie wskazad żądane klasy obiektów z wybranego połączenia: 

 

Spowoduje to wyświetlenie w oknie mapy danych z użyciem domyślnych atrybutów wyświetlania: 

 

Do nawigacji (powiększania, pomniejszania, przesuwania czy dopasowywania ekranu służą przyciski 

na pasku narzędzi – kolejno: 
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1.6 Legenda mapy - zmiana atrybutów wyświetlania 

Zmianę atrybutów wyświetlania można wykonad za pomocą okna legendy w menu kontekstowym 

(prawy przycisk myszy). Kolejnośd klas obiektów w oknie legendy determinuje kolejnośd nakładania 

się ich na mapie. Dla każdej klasy można wyłączyd wyświetlanie, lokalizowalnośd a także  za pomocą 

opcji Legend Entry Properties zmienid atrybuty wyświetlania: 

                  

Przykładowo zmiana wypełnienia obiektów klasy powiaty (admin_region_teryt_pow) i przesunięcie 

ich na szczyt legendy: 
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Dostęp do atrybutów opisowych obiektów można wykonad klikając dwukrotnie na wybrany obiekt za 

pomocą myszy (narzędzie         ) 

 

Całą tabelę atrybutów opisowych dla danej klasy obiektów wyświetlid można dzięki opcji 

Window→New Data Window: 
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Zaznaczenie obiektu na mapie powoduje zaznaczenie odpowiedniego wiersza w tabeli i odwrotnie: 

 

Lokalizację plików rastrowych wskazaną w bazie danych można zmienid (aktualizowad) dzięki opcji 

Warehouse→Images: 
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Wymaga to trybu dostępu do połączenia Odczyt/Zapis. W przypadku zmiany lokalizacji danych 

geohurtowni na dysku niezbędne jest jej wskazanie, aby móc wyświetlid rastry: 

 

1.7 Zmiana systemu współrzędnych geoprzestrzeni 

GeoMedia umożliwiają wyświetlanie danych w różnych układach współrzędnych, niezależnych od 

odwzorowania danych źródłowych. Istnieje możliwośd zmiany odwzorowania podczas pracy 

z projektem, a wszystkie dane z podłączonych projektów są przeliczane do nowego układu 

odniesienia w czasie rzeczywistym. Użytkownika nie interesuje faktyczne odwzorowanie każdego 
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z projektów - będzie ono bowiem automatycznie rozpoznane, a dane geometryczne zostaną 

przeliczone do zdefiniowanego dla GeoPrzestrzeni układu współrzędnych. GeoMedia poprawnie 

obsługują i przeliczają wszystkie Paostwowe Układy Odniesienia takie jak: Układ 2000, Układ 1992, 

Układ 1965 i Układ 1942, itd. 

W celu zmiany lub redefinicji systemu współrzędnych geoprzestrzeni wybieramy opcję 

View→Geoworkspace Coordinate System: 

    

Definicję systemu współrzędnych można wykonad ręcznie dzięki opcjom w zakładkach lub wczytad 

z pliku (*.csf). Przykładowa zmiana przestrzeni i parametrów odwzorowania: 

 

Geodezyjny układ odniesienia i parametry elipsoidy definiujemy w zakładce Geographic Space: 
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Jednostki i formaty: 

1.8 Filtry przestrzenne 

Filtry przestrzenne pozwalają na ograniczenie dostępu do danych (klas obiektów) ze względu na 

lokalizację przestrzenną. W przypadku pracy na niewielkim obszarze dostępnego zasobu wygodnie 

jest wyeliminowad obiekty poza obszarem zainteresowania. Mamy do dyspozycji trzy sposoby 

definicji filtru przestrzennego: wg widoku (dostępne zostaną obiekty aktualnie widoczne w oknie 

mapy), wg konturu (pozwala na zaznaczenie za pomocą myszy żądanego obszaru) oraz wg 

powierzchni (definicja  obszaru zapisana za pomocą obiektu w bazie danych) Przykładowo aby 

pozostawid w widoku jedynie południowo-zachodnią częśd kraju można ustawid żądany zakres mapy 

na ekranie i wybrad opcję Active Map Window Extend z paska Spatial Filter włączanego poleceniem 

menu Warehouse: 
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Filtrując dane do dyspozycji są cztery operatory przestrzenne: Coarse Overlap, Entirely Inside, Overlap 

(polecenie Spatial Filter Options): 
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Aby przywrócid widok wszystkich danych należy wybrad opcję:  

 

Ćwiczenie 2: Tworzenie i edycja obiektów 

2.1 Tworzenie geohurtowni danych 

Aby móc pracowad na własne bazie danych niezbędne jest jej utworzenie. Do tworzenia nowej 

geohurtowni danych służy polecenie Warehouse→New Warehouse: 

 

Natywnym formatem bazy danych dla Geomediów jest format ACCESS. W pierwszym kroku należy 

wskazad szablon na podstawie którego tworzymy nową bazę. Domyślnie jest to szablon normal. 

Częstym błędem jest wskazywanie w oknie wyboru szablonu docelowej lokalizacji bazy danych. 

Standardowo ten krok nie wymaga większej interwencji użytkownika, poza kliknięciem przycisku 

New: 
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Dopiero w kolejnym kroku należy wskazad docelową lokalizację tworzonego pliku bazy danych: 

 

Po wskazaniu docelowego folderu oraz nazwy pliku oraz kliknięciu Zapisz nowy plik bazy danych 

w formacie Geomedia ACCESS zostanie utworzony i automatycznie zostanie otwarte połączenie do 

niego w trybie Odczyt/Zapis. Baza jest gotowa do pracy. Status (tryb) połączenia zmieniad można 

korzystając z opcji Warehouse → Connections. 

2.2 Kalibracja rastra  

GeoMedia Professional zawierają szereg narzędzi do pracy z rastrami w dziedzinie pozyskiwania danych oraz ich 

edycji i umożliwiają precyzyjne wstawienie podkładu rastrowego przez jego transformacje do współrzędnych 

układu wektorowego. Program pozwala na pracę z rastrami zarówno binarnymi jak i obrazami w odcieniach 

szarości czy kolorowymi obrazami indeksowanymi oraz zapisanymi modelem RGB. Raster nie jest trwale 

modyfikowany, informacja o miejscu wstawienia zapisywana jest w geohurtowni, zatem aby wykonad procedurę 

rejestracji niezbędne jest utworzenie nowej geohurtowni danych. Kolejnym etapem jest geokodowanie 

współrzędnych punktów dostosowania i  właściwa rejestracja rastra. Po jej wykonaniu można przystąpid do 

pracy z rastrem np. do jego digitalizacji. 

2.3 Geokodowanie współrzędnych 

Procedura transformacji wymaga listy punktów dostosowania – punktów o współrzędnych znanych 

w układzie źródłowym i docelowym. O ile użytkownik nie musi znad wartości współrzędnych układu 

źródłowego (układem źródłowym jest układ współrzędnych pikseli na rastrze i podanie współrzędnej 

polega na wskazaniu punktu źródłowego na rastrze za pomocą myszy), to w przypadku układu 

docelowego takie współrzędne muszą byd dostarczone w formie listy. Listę współrzędnych można 

przygotowad w wielu formatach (np. txt, xls). Zanim jednak dołączony zostanie plik współrzędnych do 

bazy danych niezbędne jest określenie systemu współrzędnych dla geoprzestrzeni. System ustawid 



 
 
 

56 

można korzystając z zakładek opcji (Omówione w bloku 1) lub wczytad z pliku *.csf: 

 

W przypadku kalibracji skanów map najprostsze do wykorzystania są punkty siatki krzyży. 

Współrzędne skrajne ramki sekcyjnej można wyznaczyd na podstawie godła mapy (np. programem 

Godło.exe). Listę współrzędnych przygotowad można w pliku programu Excel, pamiętając aby 

w pierwszym wierszu opisad osie: 

 

Przygotowany w formacie Excel 97/2000/XP plik należy podłączyd do nowej bazy danych 

w GeoMediach za pomocą polecenia Warehouse → Feature Class Definition i opcji Attach. Należy 

wskazad format danych, lokalizację pliku i w przypadku Excela arkusz z danymi: 
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Po wykonaniu arkusz zostanie dołączony do bazy danych. 

Właściwą procedurę geokodowania, a więc wyświetlenia punktów w postaci wektorowej na 

podstawie współrzędnych wykonujemy za pomocą opcji Analysis→Geokode Coordinates: 

 

W oknie narzędzia należy wskazad obiekt źródłowy zawierający współrzędne (arkusz w bazie), 

wczytad lub ustawid system współrzędnych dla źródła (zazwyczaj taki sam jak dla geoprzestrzeni), 

osie układu oraz atrybuty wyświetlania punktów: 



 
 
 

58 

Po kliknięciu OK punkty zostaną zgeokodowane czyli wyświetlone na mapie: 

 

2.4 Rejestracja rastra 

Aby wykonad transformację należy raster wstawid do bazy. Można to zrobid korzystając z funkcji 

Insert→Interactive Image: 

 

Po wybraniu pliku z rastrem i nadaniu mu unikalnej nazwy w bazie, należy wskazad obszar na ekranie 

w który chcemy wstawid raster: 
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Atrybuty wyświetlania rastra zmienid można w Legend Entries Properties: 

 

Właściwa rejestracja wykonywana jest za pomocą opcji Tools → Image registration → New → Add 

Points i polega na wskazaniu punktu źródłowego i docelowego. Uruchomienie procedury musi byd 

poprzedzone wskazaniem rastra za pomocą myszy (kliknięciem w celu jego zaznaczenia): 
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Punkt źródłowy to punkt na rastrze a docelowy to punkt geokodowany. Wektory transformacji są 

zapisywane i mogą byd wykorzystane w dowolnym momencie dla dowolnej powierzchni rastrowej. 

Aby edytowad połączenia, sprawdzid residua lub błąd RMS należy kliknąd dwukrotnie poza obszarem 

rastra. Po wskazaniu par punktów rejestrację kooczymy wybierając opcję Register: 

 

Raster powinien zostad przetransformowany: 
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2.5 Tworzenie klas obiektów 

Tworzenie klas obiektów (tabel) wykonuje się wybierając znane już polecenie Warehouse → Feature 

Class Definition → New. W kolejnym oknie wskazujemy typ geometrii i strukturę tabeli. Wskazujemy 

klucz główny oraz typy danych. Przykład definicji klasy Budynki. Tu także należy wczytad system 

współrzędnych (jak dla geoprzestrzeni): 

 

2.6 Digitalizacja mapy w bazie wielodostępowej 

Digitalizacja mapy (wektoryzacja) polega na przerysowaniu treści rastrowej. Dzięki tej czynności 

uzyskuje się funkcjonalnośd grafiki wektorowej i podział treści na klasy obiektów i obiekty. Służy do 

tego polecenie Insert → Feature. Wybranie opcji spowoduje pojawienie się nowego paska narzędzi 

w którym należy wskazad klasę obiektów do digitalizacji: 

  

Teraz można przystąpid do właściwej czynności digitalizacji. Tworzenie obiektu kooczymy opcją End 

Feature w menu kontekstowym (prawy przycisk myszy). Po zakooczeniu tworzenia geometrii należy 

wpisad atrybuty opisowe obiektu: 
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Digitalizując pamiętad należy o poprawności topologicznej. Narzędziem wspomagającym zachowanie 

poprawności topologicznej są narzędzia snapowania (pasek SmartSnap): 

 

Na uwagę zasługuje również moduł snapowania do elementów rastra, który ułatwia pracę: 

 

2.7 Kontrola poprawności topologicznej 

GeoMedia Professional umożliwiają kontrolę poprawności topologicznej oraz analizę poprawności 

oraz łączności geometrii. Wykrywane są błędne elementy geometryczne, które mogą powodowad 

problemy w innych procesach (takich jak zapytania). Można znaleźd następujące błędy geometrii: 

powielone (zdublowane) punkty, pętle, nie zamknięte powierzchnie, nie uwzględnione powierzchnie 

w powierzchni ("obszary wyspowe"), nakładające się "dziury", błędne i nieznane typy geometryczne, 

puste zbiory geometrii, zbyt mała liczba linii. 

Aby wykonad sprawdzenie poprawnośd wybieramy opcję Tools → Validate Geometry: 
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Przykładowy wynik sprawdzenia poprawności klasy Budynki zawierającej błędy pokazano na 

poniższym rysunku: narzędzia: 

 

Narzędzie do sprawdzania łączności pomiędzy klasami obiektów to Tools → Validate Connectivity. 

W oknie wskazujemy parę klas obiektów do sprawdzenia oraz poszukiwane błędy łączności. 

Przykładowa analiza łączności pomiędzy budynkami: 



 
 
 

64 

  

 

Większośd błędów może zostad naprawiona automatycznie dzięki narzędziom: Tools → Fix Geometry 

i Tools → Fix Connectivity. 

Ćwiczenie 3: Praca z zewnętrzna bazą danych atrybutowych. 
Tworzenie map tematycznych 

3.1 Moduł tworzenia map tematycznych w programie GeoMedia 

W programie GeoMedia zawartośd i projekt okna mapy są definiowane z poziomu legendy. Dlatego 

również proces tworzenia mapy tematycznej rozpoczyna się komendą Add Thematic Legend Entry 

z menu Legend, która wywołuje okno dialogowe Add Thematic Legend Entry  
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Dostępne są trzy formy prezentacji kartograficznej: Standard (odpowiada standardowej zmianie stylu 

wyświetlania), Unique Value Thematic i Range Thematic. Terminologia użyta w programie nie 

pokrywa się z określeniami stosowanymi w kartografii i ostatnie dwa rodzaje przedstawieo 

tematycznych obejmują swych zakresem kilka metod kartograficznych: 

 Unique Value Thematic – odpowiada metodzie powierzchniowych jednostek 

naturalnych, zasięgów i sygnaturowej (zależnie od jednostki odniesienia) 

 Range Thematic – odpowiada metodzie kartogramu (w przypadku danych 

ilościowych), metodzie sygnaturowej (w przypadku danych jakościowych) 

W górnej części okna z listy rozwijalnej wybieramy klasę obiektów (Input features), dla której 

będziemy tworzyd mapę. 

3.2 Podłączanie danych nieprzestrzennych z zewnętrznych źródeł 

Często dane, które chcemy przedstawid na mapie są przechowywane w zewnętrznych bazach (np. 

dane statystyczne z GUS-u, dane gromadzone w bazach tematycznych, branżowych). GeoMedia 

umożliwiają podłączenie danych nieprzestrzennych do danych w postaci wektorowej w celu ich 

wizualizacji. 

W zasobach GUS (www.stat.gov.pl/bdr ) znajdź interesujące Cię informacje z zakresu ochrony 

środowiska dotyczące powiatów. Zapisz w postaci pliku .xls. Następnie podłącz je do istniejącej bazy 

– klasy obiektów powiaty. 

http://www.stat.gov.pl/bdr
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1. Pierwszy krok to przygotowanie pliku .xls do wczytania w programie GeoMedia. 

 

 

 

 

 

 

 

 

 

 

 

2. Wczytanie pliku .xls wymaga stworzenia nowej geohurtowni, a następnie podłączenia danych ze 

wskazanego pliku. 

Uwaga: Plik ten będzie plikiem tylko do odczytu! 

Z menu Warehouse wybierz New warehouse…. Na podstawie szablonu normal.mdt stwórz 

geohurtownię nadając jej nazwę. 

W celu dołączenia danych w menu Warehouse wybierz Feature Class Definition. Przycisk Attach 

umożliwia podłączanie danych do geohurtowni. 
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Aby edytowad dane (np. dodad nowe atrybuty) konieczne jest wyprowadzenie tego pliku do nowej 

klasy obiektów: Warehouse > Output to Feature Classes: 

 

3. Bazy muszą posiadad atrybut, na podstawie którego zostaną połączone (patrz skrypt). W tym przypadku 

będzie to numer TERYT i kod. Porównaj te atrybuty w obu bazach. 

 

 

Widad, że atrybut KOD zawiera w sobie atrybut TERYT (2,3 i 6,7 znak z ciągu znaków). 

W celu ujednolicenia atrybutów należy użyd funkcji (MID oraz CONCATENATE) do wykonania operacji na 

danych tekstowych. 

Funkcja MID zwraca łaocuch (String) zawierający określoną liczbę znaków z łaocucha. Składnia funkcji: 

Mid(Łaocuch, Początek ,Długośd) 
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np. MID(Kowalski,2,3)  - otrzymamy tekst: owa 

 

Funkcja CONCATENATE – wykonuje złączenie dwóch łaocuchów znaków. 

Należy dodad atrybut do bazy podłączonej z Excela, który będzie przechowywał numer TERYT 

odpowiadający temu z bazy wektorowej: 

Warehouse > Feature Class Definition > Edit… 

 

 

Aktualizacja atrybutu: 

Menu Edit > Attributes > Update Attributes: 

W oknie dialogowym Expression zbuduj wyrażenie używając funkcji Mid i Concatenate. 
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Wynik: 

 

 

4. Łączenie tabel z użyciem funkcji JOIN. 

Menu Analysis > Join… 
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Wynik: 

 

3.3 Tworzenie mapy tematycznej metodą kartogramu 

Metoda kartogramu wymaga danych względnych (patrz skrypt) Jeśli dane, które chcemy przedstawid w formie 

kartogramu są danymi bezwzględnymi (tj. wyrażone np. w ha, zł, osobach, km
2
), w prosty sposób można je 

przekształcid na dane względne. 

W GeoMediach istnieją dwa sposoby wykonania obliczeo korzystając z atrybutów w bazie: 

 Aktualizacja nowostworzonego atrybutu, 

 Atrybut funkcyjny (zostanie umówione przy analizach przestrzennych). 

Korzystając z powyższego przykładu, po podłączeniu danych z GUS-u mamy w bazie (dla powiatów) 

powierzchnię gruntów chronionych w hektarach (dana bezwzględna).  

Wykonaj mapę metodą kartogramu prezentującą procentowy udział gruntów chronionych w powiatach. 

1. Tworzymy nowy atrybut: Proc_obsz_chron 

Stworzenie nowego atrybutu jest możliwe tylko w Klasie Obiektu (nie w Zapytaniu).  
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2. Dodanie nowego atrybutu: Warehouse > Feature Class Definition  

 

Pamiętaj o odpowiednim typie danych dla nowego atrybutu. 

3. Aktualizacja nowostworzonego atrybutu: Edit > Update attributes 

 

Zwród uwagę na różne jednostki powierzchni (Pow.powiatu – km2, pow obszarów chronionych– ha). Stąd 

wyrażenie: (Input.Obszary_chron_ha/(Input.POLE_KM2*100))*100 

4. Tworzenie kartogramu: Legend > Add Thematic Legend Entry 
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Wybierz klasę obiektu I atrybut, dla którego będzie tworzony kartogram. Ustal liczbe klas i metodę podziału 

danych na klasy oraz wartośd początkową (min.0.1% obszarów chron.) 

Następnie dobierz zmienna graficzną. 

Wynik wyświetl na tle pozostałych powiatów, w których procentowy udział powierzchni obszarów 

chronionych wynosi 0. 

 

3.4 Tworzenie kompozycji mapy w oknie rozkładu 

Okno rozkładu (Layout Window) umożliwia stworzenie kompozycji mapy (np.do wydruku) wraz z 

elementami dodatkowymi tj. legendą, strzałką północy, tytułem, tabelą itp. 
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Menu Window > Show Layout Window 

Wszystkie elementy dodajemy do okna rozkładu poleceniem Insert. Po dodaniu mapy uaktywniają się 

pozostałe elementy (legenda, strzałka północy itp.) 

Edycja legendy:  Insert > Legend > Properties 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Edycja wyglądu legendy: zaznczyd pozycje Legend > Properties 
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Edycja pozycji w legendzie: zaznaczyd daną pozycję > Properties.  

Można usuwad i dodawad pozycje w legendzie. Edytowad ich rozmiar, style wyświetlania  

i opisy. Zmieniad kolejnośd wyświetlania (przyciski Up/Down).  

 

 

Opcja: Convert to Graphic -  legenda nie jest już interaktywna (zmiana na mapie nie jest odzwierciedlona w 

legendzie. 

Wstawianie kierunku północy: Insert > North Arrow (aktywne, gdy zaznaczona mapa)  

 

 

Do wyboru jest kilkanaście stylów strzałki północy. We właściwościach można zmieniad rozmiar strzałki 

północy oraz zdefiniowad kierunek. 
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Wstawianie podziałki: Insert > Scale bar (aktywne, gdy zaznaczona ramka mapy) 

 

Do wyboru kilka stylów podziałki. Możliwośd edycji praktycznie wszystkich elementów podziałki (jednostki, 

interwał, wysokośd, kolor itd.) 

Wynik: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dwiczenie praktyczne (opcjonalnie) 

Korzystając z klasy obiektów Województwa stwórz kartogram przedstawiający gęstośd zaludnienia w Polsce. 
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Ćwiczenie 4: Przegląd wybranych narzędzi do zapytań przestrzennych 

GeoMedia zawierają pakiet analiz takich jak między innymi: zapytania atrybutowe i przestrzenne, 

strefy buforowe, operacje logiczne między warstwami, mapy tematyczne, iloczyn i różnica 

przestrzenna, scalanie analityczne, atrybuty funkcyjne, agregacja przestrzenna obiektów, 

geokodowanie punktów i adresów. Dzięki technologii serwerów danych możliwe jest wykonywanie 

tych samych analiz na wielu różnych bazach danych. Wszystkie zapytania i mapy tematyczne odnoszą 

się do danych źródłowych co oznacza, że jeśli zmieniona zostanie wartośd atrybutu to wszystkie 

zapytania i mapy tematyczne odnoszące się do tego obiektu zastaną odświeżone. Ta sama reguła 

działa w przypadku analizy składającej się z kilku zapytao - zmiana parametrów któregokolwiek 

zapytania powoduje automatyczną zmianę koocowego wyniku analizy. Możliwośd budowania 

dynamicznych zapytao w powiązaniu z wynikami innych zapytao pozwala na prowadzenie analiz typu 

„co jeśli?”. Zbiór narzędzi do analiz przestrzennych w programie Geomedia znajduje się w menu 

Analysis. 

4.1 Atrybut funkcyjny (Functional Atribute) 

Zgodnie z teorią relacyjnych baz danych niepożądane jest przechowywanie w tabeli (klasie obiektów) 

bazy danych atrybutów, które można bezpośrednio uzyskad na podstawie innych atrybutów w tej 

tabeli. Analizy takie jak np. omawiana wcześniej Mapa tematyczna wymagają często wykonania 

obliczenia miar wynikających z różnych atrybutów. Przykładem może byd obliczenie gęstości 

zaludnienia (osób/km2) dla powiatów. W tabeli powiaty (baza BDO) posiadamy informację o 

populacji powiatu oraz powierzchni powiatu (inna sprawa, że powierzchnia również może byd 

obliczona na podstawie geometrii a więc danych w bazie. Dopuszcza się jednak tego typu 

redundancję ze względu na niejawny charakter geometrii w stosunku do atrybutów opisowych 

obiektów). Aby obliczyd wskaźnik gęstości zaludnienia posłużymy się narzędziem Analysis → 

Functional Attributes: 
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Przykład: 

Obliczyd gęstośd zaludnienia powiatów w Polsce. 

 

Wynik: 

 

 

Dwiczenie praktyczne (opcjonalnie) 

Obliczyd odsetek ludności zamieszkującej obszary wiejskie dla województw. Wykonad mapę 
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tematyczną. 

Edycja zapytao (Queries) 

Wszystkie zdefiniowane przez użytkownika zapytania można edytowad lub ponownie wyświetlad ich 

wynik dzięki opcji Analysis → Queries: 

 

4.2 Zapytanie atrybutowe (Attribute Query) 

Narzędzie to pozwala na wybór podzbioru obiektów z danej klasy obiektów na podstawie wartości 

atrybutów opisowych, a więc ograniczenie tabeli w bazie danych do wierszy spełniających zadany 

warunek względem jednego lub wielu atrybutów. Zdefiniowanie zapytania atrybutowego jest 

możliwe poprzez wykonanie  polecenia z Menu głównego Analysis → Attribute Query. W ujęciu 

bazodanowym jest to kreator konstrukcji klasycznego zapytania SELECT w stosunku do jednej tabeli – 

wskazanej klasy obiektów (możliwe jest odwołanie do atrybutów innej tabeli jednak w sposób mało 

elastyczny). Definicja warunku zapytania możliwa jest bezpośrednio lub za pomocą okna Filter. Wynik 

zapytania można wizualizowad na mapie lub przedstawid w formie klasycznej w tabeli. 
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Przykład: 

Wskazad wszystkie odcinki rzeki Odry w Polsce. 

 

Wynik: 

 

Użyteczną opcją jest Show Values, która pozwala na podgląd wszystkich wartości atrybutu 

występujących w tabeli. Do wyników zapytao lub klas obiektów w bazie można wykonad etykiety 

tekstowe. Służy do tego celu polecenie Insert → Label: 
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Dwiczenie praktyczne (opcjonalnie) 

Wskazad wszystkie miejscowości, których populacja jest większa od średniej populacji miejscowości 

w Polsce. Wstawid etykiety ich nazw. 

4.3 Zapytanie przestrzenne (Spatial Query) 

Zapytanie przestrzenne pozwala wybrad obiekty z danej klasy obiektów na podstawie ich relacji 

przestrzennych pomiędzy obiektami z innej klasy. Zdefiniowanie zapytania przestrzennego jest 

możliwe dzięki opcji Analysis → Spatial Query. W oknie definicji zapytania przestrzennego należy 

wskazad klasę obiektów do selekcji (górne okno wyboru klasy obiektów) oraz klasę obiektów w 

stosunku do której rozpatrujemy relację przestrzenną (dolne okno wyboru klasy obiektów) a także 

operator przestrzenny. Możliwe jest zastosowanie kryterium Filtru (zapytanie atrybutowe) do obu 

powyższych klas obiektów bezpośrednio z okna narzędzia zapytania przestrzennego. Podobnie jak w 

przypadku zapytania atrybutowego można nadad własną nazwę tworzonego zapytania, dodad krótki 

opis, zdefiniowad styl wyselekcjonowanym obiektom oraz wskazad czy wybrane obiekty mają byd 

wyświetlone w Oknie Mapy lub/i w Oknie Danych. 
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Przykład: 

Wskazad wszystkie miejscowości położone do 20 km od rzeki Odry w Polsce. 

Wynik: 

 

 

Dwiczenie praktyczne (opcjonalnie) 

Wskazad wszystkie jeziora w woj. warmiosko-mazurskim o powierzchni większej od 400 ha i mniejszej 

od 600 ha. 

Ćwiczenie 5: Przegląd wybranych narzędzi do analiz przestrzennych 

5.1 Strefa Buforowa (Buffer Zone) 

Opcja pozwala na określenie obszaru dookoła obiektów o wskazanym (stałym lub zmiennym) 

promieniu. Stworzenie bufora wokół obiektu ułatwia wyszukiwanie innych obiektów znajdujących się 

w jego zasięgu. 

a. Promieo stały 

W przypadku kiedy promieo ma stałą wartośd dla wszystkich obiektów dla których tworzymy strefę 

buforową wystarczy go zdefiniowad w oknie narzędzia. Istnieje możliwośd scalenia w jeden obiekt 

stref stykających się ze sobą. 



 
 
 

82 

 

Przykład: 

Wskazad obszar dookoła rzeki Odry o promieniu 20 km. 

Rozwiązanie: 

 

b. Promieo zmienny 

Aby móc zastosowad zmienny promieo (zdefiniowany oddzielnie dla każdego z analizowanych 

obiektów) należy dysponowad w tabeli obiektu kolumną wartości tego promienia. Można użyd 

istniejącego atrybutu lub go zdefiniowad np. atrybutem funkcyjnym. 

Dwiczenie praktyczne (opcjonalnie) 

Przy założeniu, że TYP lotniska determinuje promieo jego oddziaływania w następujący sposób: typ 1- 

50 km, typ 2 -30 km, typ 3-20 km, typ 4 – 10 km, pozostałe 5km wskaż strefy oddziaływania lotnisk w 

Polsce. 

Wynik: 
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5.2 Iloczyn i różnica przestrzenna (Spatial Intersection, Spatial Difference) 

Opcje pozwalają na wybór części wspólnej lub różnicy przestrzennej dwóch klas obiektów. W tym 

przypadku w przeciwieostwie do pozostałych analiz mamy do czynienia z generowaniem wyniku w 

postaci części geometrii obiektów z bazy. Obiekty wynikowe zapytania dziedziczą atrybuty z obiektów 

analizowanych. 

Przykład: 

Wskazad części powiatów leżące w strefie 20km dookoła rzeki Odry. W rozwiązaniu można 

wykorzystad strefę buforową. 

Rozwiązanie: 

 

 

Dwiczenie praktyczne (opcjonalnie) 

 Wskazad mosty kolejowe w Polsce. (Założenie – każde przecięcie odcinka kolei z ciekiem to most) 

 Wskazad obszary dookoła Parków Narodowych w Polsce o promieniu 10 km dookoła Parku (klasa 

obchr_region_np). 

 



 
 
 

84 

5.3 Scalanie analityczne (Analitical Merge) 

Opcja pozwala scalid w jeden obiekt wszystkie obiekty z danej tabeli lub spełniające zadany warunek 

atrybutowy lub przestrzenny. 

Przykład: 

Scalid wszystkie odcinki rzeki Odry. 

Rozwiązanie: 

Można wykorzystad zapytanie atrybutowe o rzekę Odrę i scalid wszystkie obiekty uzyskane dzięki 

niemu. W celu scalenia w jeden obiekt odcinków wszystkich cieków należy wybrad klase cieki w 

pierwszym oknie oraz opcję Merge criteria → All: 

 

5.4 Agregacja przestrzenna (Aggregation) 

Opcja pozwala na wykonanie obliczeo (atrybut funkcyjny) dla obiektów z jednej klasy (detail), które 

są w relacji przestrzenne z obiektami innej klasy (input). 

Przykład: 

Obliczyd powierzchnię strefy 20 km dookoła rzeki Odry w Polsce. 

Rozwiązanie. 

Można wykonad agregację z części powiatów znajdujących się w strefie buforowej dookoła Odry 

(zadania poprzednie) do podsumowania w tej strefie: 
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Dwiczenie praktyczne (opcjonalnie) 

Obliczyd powierzchnię części powiatów znajdujących się w strefie 20 km dookoła Odry w rozbiciu na 

województwa. 
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5.5 Złożone analizy przestrzenne – ćwiczenia praktyczne (opcjonalnie) 

1. Obliczyd liczbę miast znajdujących się w strefie oddziaływania lotnisk wg kryteriów: lotniska 

typu 1 i 2 – strefa o promieniu 30 km, pozostałe – 15 km i znajdujących się w bezpośrednim 

sąsiedztwie parków narodowych tj do 10 km od ich granicy. 

2. Obliczyd długośd niebezpiecznych odcinków dróg w rozbiciu na województwa przy 

założeniach, że najwięcej wypadków jest na drogach kategorii I, II i III, efektywny dojazd 

sprzętu ratunkowego, który znajduje się wyłącznie w miastach o populacji większej od 

100000 mieszkaoców wynosi 50 km. 

3. Wskazad potencjalne miejscowości wypoczynkowe dla Wrocławia. Założenia: maksymalna 

odległośd od Wrocławia to 100 km, miejscowośd wypoczynkowa powinna mied populację do 

5000 mieszkaoców i znajdowad się nie dalej niż kilometr od lasu, ale co najmniej 10 km od 

dróg KAT I, II i III. 
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Ćwiczenie 6: Wprowadzenie do programu ArcGIS 

6.1 Zapoznanie się z podstawowymi funkcjami w ArcCatalog 

W celu rozpoczęcia pracy z menu Start należy wybrad polecenia w kolejności: Wszystkie programy, 

ArcGIS, ArcCatalog, a nastęnie zaznaczyd wybraną partycję dysku oraz wybrany katalog, w którym 

będzie tworzony projekt. Wskazanie folderu projektowego jest również możliwe przez wybór 

polecenia połącz z folderem (Connect To Folder) i wskazanie wybranego katalogu.  

ArcCatalog zawiera trzy zakładki: 

 zawartośd (contents) – umożłiwiająca przeglądanie elementów projektu, 

 podgląd danych (preview) – zawierająca opcje umożliwiające przeglądanie geometrii obiektów 
(geography) lub przeglądanie  atrybutów w tabeli (table), 

 metadane (metadata) – umożliwiająca przegląd metadanych. 

 
Po wskazaniu folderu zostanie zapisana ścieżka dostępu w widoku zawierającym drzewo katalogów 

(Catalog Tree). 

 

Connect To Folder 

Połącz z folderem 
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6.2 Tworzenie nowych elementów projektu w ArcCatalog 

W celu utworzenia elementów projektu należy z menu Plik (File) wybrad polecenie Nowy (New) lub 

nacisnąd prawy przycisk myszy i rozwinąd listę poleceo Nowy (New).  
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Do podstawowych elementów projektu tworzonych w ArcCatalogu należą m.in.: 

 nowe foldery, 

 bazy plikowe z rozszerzeniem *.gdb (File Geodatabase) – format stworzony przez firmę ESRI 
zapewniający optymalizację zapisu danych, 

 bazy danych w formacie Microsoft Access (Personal Geodatabase), 

 warstwy tematyczne (Layer), 

 grupy warstw tematycznych, 

 pliki typu shapefile (*.shp) zawierające wraz z towarzyszącymi im plikami indeksującymi i 
plikami typu dBase(*.dbf) dane graficzne i opisowe. 

 tabele relacyjnej bazy danych (dBase Table). 

6.3 Import danych do formatów ArcGIS 

Do importu danych z innych formatów danych służy narzędzie Data Interoperability Tools znajdujące 

się w ArcToolbox (ArcCatalog>Windows>ArcToolbox). 

 

Aby wykonad import należy zdefiniowad format importowanych danych, ścieżkę dostępu do zbioru 

danych oraz ścieżkę dostępu do zbioru wyjściowego. 

 

 

Elementy zaimportowanej bazy danych są dostępne w oknie ArcCatalogu w zakładce zawartośd 

(Contents). W celu podglądu danych graficznych i opisowych należy przejśd do zakładki Podgląd 
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Danych (Preview) oraz wybrad opcję wyświetlania danych geometrycznych (Geometry) lub danych 

opisowych (Table).  

 

 

 

W celu przeglądu właściwości klas obiektów wybiera się zakładkę Zawartośd (Contents), zaznacza się 

wybraną nazwę, a następnie prawym przyciskiem myszy otwiera zakładkę Właściwości (Properties).  
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W oknie właściwości można odczytad informacje o wskazanym obiekcie. Do najważniejszych należą: 

 ogólne właściwości obiektu (General), 

 układ współrzędnych (XY Coordinate System), 

 atrybuty opisowe klasy obiektu oraz typy danych. 
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6.4 Zapoznanie się z podstawowymi funkcjami w ArcMap  

W celu rozpoczęcia pracy z menu Start należy wybrad polecenia w kolejności: Wszystkie programy, 

ArcGIS, ArcMap. Na początku pojawia się okno powitalne, w którym jest możliwośd wyboru opcji 

wyboru dokumentu mapy lub szablonu. 

 

Po wybraniu odpowiedniej opcji otwiera się okno aplikacji ArcMap zawierające pusty lub istniejący 

dokument mapy w zależności od opcji. Otwarcie istniejącego dokumentu mapy powoduje 

wyświetlenie wszystkich zapisanych wcześniej warstw tematycznych. 

 

Opcje wyboru mapy lub szablonu 

Lista wprowadzonych 

do dokumentu mapy 

warstw 

Obiekty graficzne 
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W celu wyświetlenia atrybutów opisowych klasy obiektów reprezentowanych przez warstwę (layer) 

należy ją wskazad, a następnie kliknąd prawym przyciskiem myszy i wybrad opcję Otwórz Tabelę 

Atrybutów (Open Attribute Table). 

 

Wybierając opcję Właściwości (Properties) można uzyskad informacje o wybranej warstwie 

tematycznej. Do najważniejszych należą: 

 typ geometrii klasy obiektów, 

 układ współrzędnych, w którym zapisana jest geometria klasy obiektów, 

 aktywne opcje wizualizacji warstwy, 

 wykaz atrybutów opisowych oraz typ danych, 

 aktywne opcje wyświetlania etykiet. 

 

Odwzorowanie oraz układ współrzędnych stosowane w dokumencie mapy może się różnid 

od odwzorowania oraz układu współrzędnych, w których zapisana została geometria klasy obiektów. 

W celu uzyskania informacji o odwzorowaniu oraz układzie współrzędnych stosowanym 

w dokumencie mapy należy zaznaczyd obiekt nadrzędny do warstw (Data Frame) oraz w menu 
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edycyjnym wybrad opcję Właściwości (Properties)  

 

Tworząc nowy dokument mapy wybieramy w oknie powitalnym pusty dokument (A new empty map), 

a następnie zapisujemy pod zadaną nazwą poprzez wybranie polecenia Zapisz jako (Save as) w menu 

Plik (File).  Konieczne jest, aby w nowym dokumencie mapy ustawid odwzorowanie oraz układ 

współrzędnych w oknie Właściwości porzez jedną z opcji: 

 wskazanie jednego z często stosowanych układów współrzędnych (Favorites),  

 wybór z istniejącego pliku definicji układu współrzędnych (Predefined), 

 wskazanie układu współrzędnych zastosowanego dla wprowadzonej do okna mapy warstwy (Layers), 

 skopiowania układu współrzędnych z klasy obiektów w innym projekcie (Funkcja Import). 
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6.5 Korzystanie z serwisów WMS w ArcGIS 

Chcąc korzystad z zewnętrznych baz danych należy uzyskad dostęp do serwera WMS z poziomu 

ArcCatalog wybierając polecenie Dodaj Serwer WMS (Add WMS Server).  

 

 

W oknie konfiguracji połączenia z serwerem WMS należy podad adres URL  serwera, a następnie 

wybrad polecenie Pobierz Warstwy (Get Layers).  

Wybierając w aplikacji ArcMap polecenie Dodaj Dane   wskazujemy zakładkę GIS Servers, 
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a następnie żądany serwer WMS. 

 

W oknie mapy pojawią się warstwy tematyczne udostępniane przez serwer WMS. Warstwy 

tematyczne udostępniane przez serwer WMS Generalnej Dyrekcji Ochrony Środowiska 

(http://wms.gdos.gov.pl/geoserver/wms?): 

 

Ćwiczenie 7: Tworzenie i edycja danych 

7.1 Tworzenie klas obiektów 

Tworzenie klas obiektów odbywa się z pozycji aplikacji ArcCatalog. W tym celu należy wybrad 

polecenie Nowy (New), a następnie Klasa Obiektów (Feature Class). 
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Polecenie to wywoła okno dialogowe, w którym  definiuje się nazwę, alias oraz typ geometrii nowych 

obiektów. W kolejnym kroku wybieramy układ współrzędnych prostokątnych, w którym zapisywane 

będą współrzędne tworzonych obiektów. 

7.2 Wektoryzacja wybranych warstw tematycznych  

Tworzenie obiektów wektorowych odbywa się z użyciem narzędzia Edytor (Editor) dostępnego 

w menu Widok (View), Paski Narzędziowe (Toolbars). Przed rozpoczęciem digitalizacji należy daną 

klasę obiektów uruchomid w trybie edycji pleceniem Start Edycji (Start Editing). W oknie Zadanie 

(Task) wybieramy polecenie tworzenia nowych obiektów, natomiast w oknie Cel (Target) wybieramy 

warstwę do edycji. 
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Digitalizacją wykonujemy wskazując punkty załamania obiektu przy użyciu narzędzia Sketch Tool 

oznaczonego symbolem ołówka. Utworzenie obiektu następuje po wskazaniu punktów załamao 

oraz naciśnięciu klawisza funkcyjnego F2. Po wektoryzacji obiektów należy uzupełnid atrybuty 

opisowe obiektów. 

 

Pewne atrybuty charakteryzujące geometrię obiektu, takie jak obwód i pole powierzchni można 

obliczyd przy pomocy funkcji obliczeniowej (Calculate Geometry), wywoływanej poprzez 

zaznaczenie aktualizowanego atrybutu,  przyciśnięcie prawego przycisku myszy oraz wybranie 

opcji obliczenia wybranych wartości. Wymagane jest wskazanie układu współrzędnych oraz 

jednostek, w którym zadane wielkości mają byd obliczone. 

 

Po zakooczeniu digitalizacji konieczne jest zapisanie wprowadzonych obiektów poprzez polecenie 

Zapisz Edycję (Save Edits) oraz zakooczenie edycji poleceniem Zakoocz Edycję (Stop Editing). 
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7.3 Edycja danych graficznych i opisowych 

W celu podstawowej edycji istniejących obiektów używamy również narzędzia Edytor (Editor) 

przedstawionego powyżej. Edycja obiektów wektorowych polega najczęściej na dodaniu, 

usunięciu lub przesunięciu jego wierzchołków. Wymaga to wprowadzeniu warstwy w stan edycji, 

a następnie wskazaniu edytowanego obiektu w oknie mapy narzędziem edycji (Edit Tool). 

Dwukrotne kliknięcie w obrysie obiektu uaktywni edytowane wierzchołki. W celu usunięcia lub 

dodania punktu obrysu należy wybrad odpowiednie polecenie (Insert Vertex – wstawienie, 

Delete Vertex – usunięcie). 

 

Edycja atrybutów opisowych odbywa się poprzez wpisanie nowych wartości w tabeli atrybutów. 

Po zakooczeniu edycji zmiany należy zapisad i zamknąd tryb edycji. 

7.4 Eksport danych  

Utworzone poprzez digitalizacje dane można eksportowad do innych formatów stosowanych 

przez wiodące programy GIS. Eksport danych odbywa się przy użyciu narzędzia Data 

Interoperability Tools oraz opcji eksportu (Quick Export). 

 

Funkcja Quick Export wywołuje okno dialogowe, w którym należy  zdefiniowad eksportowane 
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warstwy, docelowy format oraz układ współrzędnych. 

 

 

Ćwiczenie 8: Tworzenie map tematycznych  

8.1 Moduł tworzenia map tematycznych 

ArcGIS zawiera rozbudowany moduł tworzenia map tematycznych znajdujący się w oknie Layer 

Properties w zakładce Symbology. Cały proces opracowania mapy - od wyboru metody prezentacji, 

atrybutu, do określenia zmiennej graficznej - odbywa się w tym oknie. 

 

Krótki opis metody 
prezentacji danych 

 

Fragment przykładowej 

mapy 
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Dostępne sposoby prezentacji danych, wyświetlone w części Show podzielone są na grupy: Features, 

Categories, Quantities, Charts, Multiple Attributes, a te zawierają różne typy. Wyróżnienie takich grup 

nie jest przypadkowe, lecz związane ze skalą pomiarową zjawisk: metody jakościowe są w grupie 

Categories , a w grupie Quantities są metody dotyczące danych liczbowych. 

W programie ArcGIS możliwe jest opracowanie mapy sześcioma metodami kartograficznymi: 

 Metoda kartodiagramu: 

o Graduated symbols z grupy Quantities to kartodiagram prosty w skokowej wyrażony 

dowolnym symbolem 

o Proportional symbols z grupy Quantities to kartodiagram prosty w skali ciągłej 

wyrażony dowolnym symbolem 

o Pie z grupy Charts to kartodiagram kołowy strukturalny w skali ciągłej 

o Bar/column z grupy Charts to kartodiagram słupkowy złożony w skali ciągłej 

o Stacked z grupy Charts to kartodiagram słupkowy sumaryczny strukturalny 

 Metoda kartogramu: 

o Graduated colors z grupy Quantities 

 Metoda kropkowa:  

o Dot density z grupy Quantities 

 Metoda sygnaturowa: 

o Single symbol z grupy Features 

o Unique values z grupy Categories dla danych odniesionych do punktów lub linii 

 Metoda zasięgów 

o Unique values z grupy Categories dla danych odniesionych do powierzchni 

 Metoda powierzchniowych jednostek naturalnych 

o Unique values z grupy Categories dla danych odniesionych do powierzchni 

 

Metody kartogramu i dazymetryczna pozwalają na przestrzenną lokalizację danych ilościowych 

względnych odniesionych do powierzchni (patrz skrypt - Rozdział II). W przypadku kartogramu 

jednostki odniesienia są z góry założone (zwykle jednostki administracyjne), natomiast na mapie 

dazymetrycznej wynikają ze zmienności samego zjawiska. W badaniach dotyczących środowiska 

przyrodniczego jest to szczególnie ważne. 

Wykonaj mapę dazymetryczną przedstawiającą procentowy udział gruntów ornych chronionych na 

terenie woj. dolnośląskiego. 

W celu stworzenia mapy wykorzystamy warstwę mapy sozologicznej: Grunty orne chronione 
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(Grunty_ch). Natomiast jednostkami odniesienia będą pola regularnej siatki systemu Temkart 

(„oczko” siatki o wymiarach 1km x 1km).  

Dane wejściowe:  

- siatka Temkart pokrywająca obszar woj.dolnośląskiego (Temkart_1km_DS) 

 - zasięg występowania gruntów ornych chronionych (Grunty_ch) 

8.2 Przekształcenie danych jakościowych (mapa zasięgów) na dane ilościowe 

Proces ten obejmuje kilka kroków: 

1. Analiza przestrzenna Clip (Wytnij) 

Należy wydzielid w obrębie każdego pola odniesienia powierzchnię gruntów chronionych. 

Posłuży do tego narzędzie Clip (Wytnij): Analysis Tools > Extract > Clip 

 
 

Efekt: 

 

 

 

 

 

 

 

 

 

2. Obliczenie powierzchni “wyciętych” fragmentów gruntów chronionych. 

Dodaj nowy atrybut (np. Pow_gr_chron), który będzie zawierał informację o powierzchni 

gruntów chronionych w obrębie jednostki odniesienia: 

 W oknie tabeli przycisk Options > Add field… 

Następnie oblicz tę powierzchnię:  

Input feature Clip feature Output feature 
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3. Przygotowanie bazy Temkart do obliczenia procentowych udziałów gr.chronionych. 

Dodaj dwa atrybuty  Options > Add field… : 

 - Pow_gr_chron_m2 (atrybut przechowujący powierzchnię gr. chronionych),  

- Proc_gr_chron (atrybut przechowujący procentowy udział powierzchni gr. ornych 

chronionych w pow.jednostki odniesienia) 

Nadaj odpowiednie typy danych tym atrybutom. 

4. Operacja JOIN 

Aby obliczyd procentowy udział gr.chronionych w jednostce odniesienia, dane dotyczące 

powierzchni gruntów chronionych muszą zostad dodane do bazy Temkart. 

Połączenia dwóch (lub więcej) tabel (=klas obiektów) wykonuję się przy użyciu funkcji JOIN. 
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8.3 Aktualizacja atrybutów w bazie Temkart 

Do obliczania wartości atrybutów (na podstawie atrybutów tej samej tabeli oraz tabel 

przyłączonych) służy funkcja Field Calculator 

 
 

Nowostworzonemu atrybutowi ‘Powierzchnia gruntów chronionych m2’ przypiszemy 

wartości z tabeli przyłączonej, która przechowuje informacje o powierzchni tych gruntów: 

 
Dane zostały zaktualizowane, więc można usunąd podłączoną tabelę:  
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Atrybut ‘Procentowy udział gruntów ornych chronionych’ należy zaktualizowad posługując się 

tą sama funkcją – wpisad wyrażenie: 

[Pow_gr_chron_m2] / [POWIERZCHNIA]*100 

 

Kooczy to proces przejścia z danych jakościowych (zasięg występowania gruntów ornych 

chronionych) na ilościowe (procentowy udział tych gruntów w jednostce odniesienia). Można 

teraz przystąpid do wizualizacji.   

8.4 Tworzenie mapy tematycznej metodą kartogramu 

Uwaga: Przy wyborze typu mapy tematycznej ‘Graduated colors’ może pojawid się 

ostrzeżenie: 

 
Wynika to z faktu, że domyślna liczba jednostek odniesienia, które można przedstawiad w 

formie map tematycznych wynosi 10 000. Natomiast w bazie Temkart takich jednostek jest 

ponad 20 000. Należy więc zmienid tę liczbę: przycisk Classify… > Sampling 
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W oknie tworzenia/edycji mapy tematycznej należy wskazad atrybut, dla którego będzie 

tworzona mapa. Dobiera się tu również zmienną wizualną (skalę barw). Najodpowiedniejszą 

zmienną dla mapy dozymetrycznej (kartogramu) jest walor.  

 
 

Przycisk Classify otwiera nowe okno dialogowe klasyfikacji danych: 

 
 

Określamy tu liczbę przedziałów klasowych, metodę podziału (do wyboru 7 metod) oraz 

mamy możliwośd wyłączenia pewnych danych z obliczeo (Exclusion).  

Wskazane jest oddzielnie potraktowad pola, w których procentowy udział gruntów ornych 

chronionych wynosi 0. (warunek: ‘Proc_gr_chron’ < 0.1) 
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Jako metodę podziału danych na klasy wybierz: Natural Breaks (Jenks) – jest to podział 

iteracyjny; granice przedziałów są wyznaczone metodą Jenksa. 

 

Wynik: 

 
 

8.5 Kompozycja mapy w oknie rozkładu 

Okno rozkładu (Layout View) umożliwia stworzenie kompozycji mapy (np.do wydruku) 

wraz z elementami dodatkowymi tj. legendą, strzałką północy, tytułem, tabelą itp. 

View > Layout View 

1. Wszystkie elementy dodawane są z poziomu menu Insert 
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2.  Wstawianie legendy. 

Kreator Legendy w kilku krokach, w których szczegółowo określamy: elementy legendy, 

nazwę, obramowanie, rozmiary pozycji w legendzie, odstępy pomiędzy nimi itp., pozwala na 

stworzenie legendy według wymagao użytkownika. 

 

W każdej chwili można edytowad wygląd legendy – dwukrotnie klikając na legendę otwiera 

się okno dialogowe Legend Properties, w którym można edytowad praktycznie każdy element 

legendy: 

 

3. Wstawianie kierunku północy: Insert > North Arrow 

 
Do wyboru jest ogromna liczba stylów strzałki północy. We właściwościach można 
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zmieniad rozmiar strzałki północy, kolor, czcionkę oraz zdefiniowad kierunek. 

4. Wstawianie podziałki: Insert > Scale bar  

 
Podobnie jak ze strzałką północy, do wyboru jest bardzo duża liczba stylów podziałki, a 

we właściwościach można edytowad praktycznie każdy element podziałki. 

 

5. Opcja: Convert to Graphic -  legenda nie jest już interaktywna (zmiana na mapie nie jest 

odzwierciedlona w legendzie. 

6. Wynik: 
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Ćwiczenie 9: Analizy przestrzenne - wektorowy model danych 

9.1 Zapytania atrybutowe 

Połącz się ze wskazanym przez prowadzącego zajęcia serwisem i pobierz bazę z danymi . Zmieo 

nazwę na Wektor1.gdb. Wykonaj zapytania atrybutowe zdefiniowane w skrypcie: 

9.2 Proste analizy przestrzenne na modelu wektorowym danych 

Dysponując  geobazą o nazwie Wektor1.gdb wykonaj proste analizy przestrzenne  wykorzystując 

operatory przestrzenne zdefiniowane w skrypcie.;  

Ćwiczenie 10: Analizy wektorowe realizowane przy pomocy 
geoprzetwarzania 

Dane do dwiczenia: geobaza plikowa Wektor2.gdb w której znajdują się klasy obiektów RZEKI, 

ZLEWNIA – obrazuje granice zlewni, NACHYLENIE – w atrybucie Przedzialy ma zdefiniowane trzy 

poligony oznaczone liczbowo 1,2,3, które reprezentuja odpowiednio: nachylenia od 0 do 5 stopni, od 

5 do 15 stopni i od 15 stopni wzwyż , UZYTKOWANIE – poszczególne pokrycia terenu, w tym grunty 

orne.. 

 W dwiczeniu należy znaleźd tereny, które stanowią potencjalne zagrożenie dla jakości wody w 

podanej zlewni, przy założeniach: 

- największe zagrożenie pochodzi od gruntów ornych ze względu na chemizację rolnictwa, 

- wraz ze wzrostem nachylenia terenu rośnie zagrożenie spłukania zanieczyszczeo (od nachyleo 5 

stopni w górę), 

- przyjmujemy, że zasięg gruntów ornych, które mogą zanieczyszczad rzekę wynosi 250 metrów od jej 

nurtu; 

Poniżej przedstawiono kolejne kroki konieczne dla wykonania dwiczenia: 

1. Uruchom program ArcMap. 

2. Dodaj do projektu wymienione warstwy; dobierz symbolizację. 
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3. Czerwonym przyciskiem z ikoną skrzynki narzędziowej włącz okno ArcToolbox; kliknij prawym przyciskiem 

myszy na nagłówek tego okna i załóż nowy Toolbox nadając mu nazwę „Moje Analizy”. 

4. Kliknij prawym przyciskiem myszy na Moje Analizy załóż nowy model; pojawi się okno, w którym model 

będzie budowany; w menu Model->Model Properties wpisz nazwę i etykietę „OchronaZlewni”. 

5. W głównym menu programu rozwio Tools-> Options i wybierz zakładkę Geoprocessing i wybierz przycisk 

Environment. W polu Current Workspace podaj ścieżkę do geobazy Wektor2.gdb;nastepnie w polu Scratch 

Workspace skopiuj tą samą ścieżkę do geobazy, ale zmieo jej nazwę na Temp.gdb. 

6. W skrzynce narzędziowej ArcToolbox rozwio grupę Analysis Tools i dalej podgrupę Extract; przeciągnij 

narzędzie Clip do okna modelu; prostokąt reprezentuje narzędzie Clip (wycięcie) i dwukrotnie kliknięcie na 

niego otwiera okno narzędzia, owal reprezentuje dane wynikowe; kiedy wszystkie ustawienia są wykonane 

prawidłowo elementy te uzyskują kolory: prostokąt staje się pomaraoczowy, owal z wynikami zielony, a 

dane wejściowe niebieskie; jako Input Features ustaw NACHYLENIA, Clip Features ZLEWNIA, a wynik (Output 

Feature Class) nazwij Nachylenia_Zlewnia; za pomocą tego narzędzia zyskujemy pewnośd, że dalsza praca 

z nachyleniami odbywad się będzie jedynie w obrębie zlewni. 
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7. W ArcToolbox-ie rozwio grupę Data Management Tools->Layers and Table Views i przeciągnij do modelu 

Make Feature Layer; jako dane wejsciowe wybierz Nachylenia_Zlewnia a w Expression skonstruuj wyrażenie 

„Przedzialy = 2 or Przedzialy = 3”, wynik nazwij Wieksze_Nachylenia. 

8. Raz jeszcze przeciągnij do modelu narzędzie Make Feature Layer; warstwa wejściową jest UZYTKOWANIE, 

Expression ma postad: "NAZWA" = 'Grunty_orne'. 

 

9. Z narzędzi Analysis Tools->Overlay przeciągnij do modelu Intersect (przecięcie); jako warstwy wejściowe 

wybierz Grunty_orne i Wieksze_Nachylenia; warstwę wynikową nazwij Grunty_nachylenia.  

10. Z narzędzi Analysis Tools->Proximityprzeciągnij do modelu Buffer (bufor); jako warstwę wejściową ustaw 

RZEKI, warstwę wynikowa nazwij Bufor, i wpisz wielkośd bufora 250 metrów. 

11. Ponownie przeciągnij narzędzie Intersect; warstwy wejściowe: Bufor oraz Grunty_Nachylenie, Warstwę 

wynikową nazwij Wynij_analizy. 

12. Kliknij na warstwę wejściową NACHYLENIA prawym przyciskiem myszy i wybierz Model Parameter; 

spowoduje to pojawienie się litery P obok symbolu na modelu; podobnie zrób z innymi warstwami 

wejściowymi oraz z warstwą wynikową; ustawienie elementu jako atrybutu Modelu powoduje, że będzie on 

widoczny w modelu, gdy będzie on otwierany jako osobne okno oraz będzie możliwa jego zmiana; kliknij w 

symbol warstwy wynikowej prawym przyciskiem myszy i wybierz Add to Display, aby wynik automatycznie 

był pokazywany na bieżącej mapie; kliknij prawym przyciskiem myszy na symbol narzędzia Buffer i wybierz 

Make Variable->From Parameter->Distance; pojawi się jasny niebieski owal reprezentujący szerokośd 

bufora; ustaw go jako parametr modelu; Zapisz model i zamknij jego okno. 
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13. Uruchom nowo powstałe narzędzie OchronaZlewni; otwiera się okno; w którym widoczne są wszystkie 

elementy zdefiniowane jako parametry modelu; W każdej chwili można wrócid do modelu i go dopracowad 

poprzez wybranie modelu prawym przyciskiem myszy do edycji; Jednym z możliwych ulepszeo jest zmiana 

nazw warstw wejściowych wyświetlanych na ich symbolach w modelu; nazwy te są widoczne w oknie jako 

tytuły pól i nie mają wpływu na zasadnicze nazwy warstw, których są reprezentantami. 

 



 
 
 

114 

 

14. Wypróbuj działanie analizy dla innych wielkości bufora niż 250 metrów; w oknie zgłaszane jest ostrzeżenie 

przed błędem, dlatego, że przy kolejnych uruchomieniach analizy warstwa wynikowa już istnieje, jednakże 

w ustawieniach systemowych można zaznaczyd w menu Tools->Options->Geoprocessing nadpisywanie 

wyników analizy „Overwrite the outputs of geoprocessing operations”; poniżej wyniki uruchomienia analizy 

dla założonych 250 metrów oraz dla 1000 m. 
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15. Ustaw jako parametry modelu także inne właściwości; np. wyrażenie wybierające przedziały nachyleo teren. 

16. Powyższa analiza ma wyłącznie uzmysłowid zakres możliwości jakie można uzyskad przez użycie modeli.  

Rzeczywista analiza zagrożeo dla jakości wód wymagałaby zdecydowanie większej liczby danych i udziału 

ekspertów w określeniu parametrów zgodnie z najnowszą wiedzą. Pożyteczne też byłoby zastosowanie 

danych w modelu rastrowym, który omówiony jest w kolejnym punkcie. 

 

Dwiczenie praktyczne (opcjonalnie) 

Dysponując geobazą Dane.gdb wykonaj model, w którym wyszukuje się miejscowości położone 

w parkach krajobrazowych lub ich bezpośrednim sąsiedztwie (do 2 km), leżące nie dalej niż 100 km 

od miejsca wyjazdu i posiadające populację poniżej 5 tysięcy ludzi. Ustaw wybór miejsca wyjazdu jako 

parametr modelu. 
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Ćwiczenie 11: Proste analizy przestrzenne - rastrowy model danych  

Połącz się z serwisem SRTM (http://srtm.csi.cgiar.org/SELECTION/inputCoord.asp). Jest to serwis 

udostępniający za darmo dane wysokościowe dla całego świata. Można je wykorzystywad dla 

niekomercyjnych zastosowao (Users are  prohibited from  any commercial,  non-free resale,  or 

redistribution without explicit written permission from CIAT. Users should acknowledge CIAT  as the 

source used  in the creation  of any reports,  publications, new data  sets, derived products, or 

services resulting from the use of this data set. CIAT also request  reprints of  any publications  and 

notification  of any  redistributing efforts.). Źródło danych to:  Jarvis A., H.I. Reuter, A.  Nelson, E. 

Guevara, 2008, Hole-filled  seamless SRTM data V4, International  Centre for Tropical  Agriculture 

(CIAT), available  from http://srtm.csi.cgiar.org. Załaduj na dysk lokalny raster z danymi 

wysokościowymi dla obszaru Polski. Załóż nowy projekt w ArcMap, nadaj ramce danych układ 

współrzędnych 1992. Następnie wczytaj raster do projektu. Kliknij prawym przyciskiem myszy na 

nazwę rastra i wybierz Data->Export Data. W opcji Spatial reference wybierz Data Frame (current). 

Zapisz w dowolnym folderze w formacie grid. Nastepnie wytnij obszar na którym będzie wykonywana 

dalsza praca. W tym celu w ArcToolbox wybierz Data Management Tools -> Raster -> Raster 

Processing -> Clip. Jako obiekt wycinajacy Clip Wskaż „obszar” z geobazy  AnalizyRastrowe1.gdb. 

Wynik zapisz jako warstwę o nazwie NMT w tejże reobazie. Skopiuj tą warstwę do geobazy 

AnalizyRastrowe2.gdb. Wykorzystując tak przygotowane dane wykonaj proste analizy rastrowe 

opisane w skrypcie. 

Ćwiczenie 12: Analizy rastrowe realizowane przy pomocy 
geoprzetwarzania 

Dane do dwiczenia: geobaza plikowa AnalizyRastrowe2.gdb w której znajduje się klasa obiektów 

Drogi oraz dwie warstwy rastrowe, NMT z numerycznym modelem terenu oraz Uzytkowanie 

w której znajdują się klasy pokrycia terenu.  

W dwiczeniu należy znaleźd potencjalne tereny po inwestycję, przy założeniach: 

- teren nie powinien się znajdowad dalej niż 1 km od dróg, aby uniknąd kosztu wybudowania drogi 

dojazdowej, 

- wraz ze wzrostem nachylenia terenu rośnie koszt inwestycji, w związku z koniecznością wykonania 

prac ziemnych, 

- inwestycja może byd zlokalizowana na obszarach, którym nadaje się „wagi” wskazujące na 

przydatnośd i niższy koszt wykonania. Będą to grunty orne (8 pkt.), uprawy (6 pkt.) – są to złożone 

uprawy wraz z działkami, lasy (3 pkt.), łąki (5 pkt.). Tereny zabudowane, wody, tereny przemysłowe 

i odkrywkowe są wyłączone z wyszukiwania. 

Są to oczywiście sztuczne założenia, mające na celu zapoznanie z możliwościami modelowania 
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rastrowego. W rzeczywistych przypadkach określenie wpływu poszczególnych czynników na wynik 

analizy zależy od przepisów prawnych, wiedzy ekspertów na dany temat, wiarygodności danych itd.  

Poniżej przedstawiono kolejne kroki konieczne dla wykonania dwiczenia: 

1. Uruchom program ArcMap, 

2. Dodaj do projektu warstwę rastrową NMT; dobierz symbolizację, 

 

 

3. Klikając prawym przyciskiem myszy na puste, szare pole obok menu programowego, włącz okno 

rozszerzenia Spatial Analyst; rozwio listę poleceo i wybierz Surface Analysis->Hillshade; otrzymasz 

cieniowany model przestrzenny terenu. 
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4. Dodaj do projektu warstwę rastrową Użytkowanie; dobierz symbolizację. 

5. Dodaj do projektu klasę obiektów Drogi. 

 

6. Kliknij prawym przyciskiem myszy na warstwę Użytkowanie i wybierz Properties (właściwości), w zakładce 

Display wpisz wartośd 40% do komórki Transparency (Przezroczystośd). 



 
 
 

121 

 

 

7. Czerwonym przyciskiem z ikoną skrzynki narzędziowej włącz okno ArcToolbox; kliknij prawym przyciskiem 

myszy na nagłówek tego okna i załóż nowy Toolbox nadając mu nazwę „Moje Analizy”. 

8. Kliknij prawym przyciskiem myszy na Moje Analizy załóż nowy model; pojawi się okno, w którym model 

będzie budowany; w menu Model->Model Properties wpisz nazwę i etykietę „Inwestycja”. 

9. W zakładce Environments rozwio General Settings i zaznacz Current Workspace, Extent, Scratch Wokspace; 

rozwio też Raster Analysis i zaznacz Cell Size; następnie wciśnij przycisk Values; W obu ustawieniach 

Workspace wskazuje się ścieżkę dostępu folderu, który pełni rolę przestrzeni roboczej; dzięki temu nie 

trzeba w wykonywanej analizie za każdym razem podawad całej ścieżki zapisu wyniku, wystarczy zmienid 

jego domyślną nazwę; w polu Extent (zasięg) należy rozwinąd listę i wskazad NMT, aby mied pewnośd, że 

wyniki analiz będą tego samego rozmiaru co warstwa NMT. W opcji Cell Size należy wskazad NMT, dzięki 

czemu wynikowe analizy będą miały tę samą rozdzielczośd co warstwa źródłowa. 

10. Rozwio zestaw Spatial Analyst w oknie Toolbox; następnie rozwio wewnątrz Spatial Analyst grupę Surface, 

wskaż narzędzie Slope (nachylenia) i przeciągnij wskaźnikiem myszy na okno modelu; W oknie modelu 

pokazały się dwa symbole, prostokąt reprezentuje narzędzie Slope i dwukrotnie kliknięcie na niego otwiera 

okno narzędzia, owal reprezentuje dane wynikowe; kiedy wszystkie ustawienia są wykonane prawidłowo 

elementy te uzyskują kolory: prostokąt staje się pomaraoczowy, owal z wynikami zielony, a dane wejściowe 

niebieskie; kliknij podwójnie na prostokąt i wybierz wartości: Input raster (raster wejściowy) -> NMT, Output 

Raster (raster wynikowy) -> Nachylenie (wpisuję się tylko nazwę pozostawiając pozostałą  częśd ścieżki 

dostępu; kliknij prawym przyciskiem myszy na Nachylenia i zaznacz Add to Display (wyświetlenie wyniku 

w bieżącej ramce danych); następnie kliknij prawym przyciskiem na prostokąt Slope i wybierz Run 



 
 
 

122 

(Uruchom); dzięki temu można na bieżąco kontrolowad wyniki cząstkowe 

w modelu.  

 

11. Spatial Analyst Tools rozwio grupę Distance i przeciągnij do modelu Euclidean Distace (Odległośd 

Euklidesową); uruchom narzędzie i ustaw: Input -> Drogi, Output-> Odleglosc; ustaw Odleglosc jako 

widoczną (Add to Display) a następnie kliknij prawym przyciskiem narzędzie i uruchom. Uzyskana w ten 

sposób mapa reprezentuje odległości od każdej komórki rastra do najbliższej drogi. 
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12. Rozwio grupę Reclass i przeciągnij na model narzędzie Reclassify (Reklasyfikacja); Input raster wybierz 

Nachylenia; kliknij na Classify i zmieo metodę na Equal Interval, zamknij a następnie kliknij Reverse new 

values; dzięki tym operacjom nachylenia zostały podzielone na dziesięd równych przedziałów i najniższym 

nachyleniom przypisano najwyższe wartości. 

W polu Output raster podaj nazwę RecNach; zamknij okno; ustaw RecNach jako Add to Display; Uruchom 

narzędzie. 

13. Przeciągnij ponownie Reclassify na model; Input raster->Odleglosc; kliknij Classify, wybierz metodę Equal 

inteval, ustaw istnienie dwóch przedziałów, następnie znów zmieo metodę na Manual i ręcznie zmieo niższą 

z dwóch wartości po prawej stronie okna na 1000; zamknij okno; jako Output raster wpisz nazwę Rec_Odl; 

zamknij okno; ustaw ja jako Add to display i uruchom narzędzie; dzięki tym działaniom podzieliliśmy 

odległości na dwie grupy: do 1000 metrów i powyżej tej wartości. 
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14. Rozwio w Toolbox-ie grupę Overlay (nakładanie) i przeciągnij do modelu Weighted Overlay (Nakładanie 

Wagowane); uruchom narzędzie; za pomocą czarnego plusa w górnej części okna dodaje się kolejne rastry 

do analizy; dodaj Rec_Nach, na dole w polach wpisz wartości From 1, To 10, By 1; dzięki temu rozszerzona 

została skala do dziesięciu przedziałów które mamy w zdefiniowane w Rec_Nach; dopilnuj aby w tabeli 

wartości w kolumnie Scale Values były prawidłowe kolejne liczby; dla wartości wejściowych 1,2,3 czyli 

najmniej korzystnych zmieo wartośd na Restricted, co oznacza, że nie będą one brały udziału w dalszej 

analizie; 

Czarnym plusem dodaj kolejną warstwę Rec_Odl, dla wartości 1 wybierz 10 punktów, dla wartości 2 wybierz 

Restricted, tym sposobem eliminujemy komórki dalsze niż 1 km od dróg;  

Dodaj kolejną warstwę Uzytkowanie; tym razem jako Input field wybierz NAZWA;  przypisz podane na 

początku dwiczenia wartości poszczególnym zmiennym : grunty orne (8 pkt.), uprawy (6 pkt.), lasy (3 pkt.), 

łąki (5 pkt.), tereny zabudowane, wody, tereny przemysłowe i odkrywkowe jako Restricted; kliknij przycisk 

Set Equal Influence, aby ustawid równorzędny wpływ poszczególnych warstw na analizę; nazwij wynik jako 
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Wagowany; zamknij okno; ustaw jako Add to Display i uruchom narzędzie; następnie dobierz symbolizację. 

 

 



 
 
 

126 

 

15.  Rozwio grupę Conditional w Toolboxie i przeciągnij do modelu narzędzie Con; Jako Input conditional raster 

wybierz Wagowany; w polu Expression wybierz „VALUE” = 9; jako Input true raster wskaż ponownie 

Wagowany; pole Input False Raster pozostaw puste; Jako nazwę wpisz Najlepsze; zamknij okno; ustaw Add 

to Display i uruchom narzędzie; 

W tej opcji dokonuje się „wycięcie” najkorzystniejszych pól z punktu widzenia analizy.; ponieważ najwyższa 

w wartośd z poprzedniego etapu wynosi 9 wyrażenie (expression) sprawdza każdą komórkę i jeśli występuje 

ta wartośd, jest ona ponawiana, a jeśli nie występuje powstaje miejsce puste (NO DATA); w ten sposób 

otrzymujemy szukane zgodnie z założeniami miejsca pod inwestycje. 
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16. Można dokonad zamiany wyniku na postad wektorową; w tym celu w Toolbox-ie rozwio Conversion Tools-

>From Raster->Raster to Polygon i przeciągnij tą funkcję do modelu; Jako input raster wybierz Najlepsze, 

jako Output raster wpisz Wynik. 
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Zapisz model oraz projekt; jeżeli czas pozawala poeksperymentuj z modelem; 

Jak zostało wspomniane na początku dwiczenia, w zależności od konkretnego przypadku można w tego typu 

analizach wykorzystywad inne dane; jeśli przykładowo inwestycją miałby byd obiekt przemysłowy 

należałoby wziąd pod uwagę obszary chronione i i ich strefy ochronne, warunki hydrologiczne, glebowe, 

strukturę własności i  wiele innych wynikających z przepisów prawa. 

 

Dwiczenie praktyczne (opcjonalnie) 

Dysponując warstwami jak w powyższym dwiczeniu NMT, wykonaj analizę (uproszczoną oczywiście) 

znalezienia miejsca pod założenie winnicy. Warunki do spełnienia: nachylenie zboczy od 10 do 40 stopni, 

ekspozycja w stosunku do stron świata (Aspect) – południe, południowy zachód i zachód, na gruntach 

ornych i nie dalej niż 1500 metrów od drogi. 

 

W niektórych zadaniach analizy rastrowej i wektorowej użyto danych CLC. Dane te udostępniane są na stronach European Environment 

Agency za zasadach: EEA standard re-use policy: unless otherwise indicated, re-use of content on the EEA website for commercial or 

non-commercial purposes is permitted free of charge, provided that the source is acknowledged 

(http://www.eea.europa.eu/legal/copyright). Copyright holder: European Environment Agency.  

Jarvis A., H.I. Reuter, A.  Nelson, E. Guevara, 2008, Hole-filled  seamless SRTM data V4, International  Centre for Tropical  Agriculture 

(CIAT), available from http://srtm.csi.cgiar.org.  
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